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Partnerships (1065)

THE BASICS OF DATA ENTRY FOR A PARTNERSHIP 
(1065) RETURN ARE THE SAME AS FOR THE 1040. 
NAVIGATE THROUGH DATA ENTRY, FIELD- AND 
SCREEN-LEVEL HELPS, AND KEYBOARD SHORTCUTS 
JUST AS YOU DO IN THE 1040 PROGRAM. SEE THE 
2020 DRAKE TAX USER’S MANUAL FOR THE 
BASICS OF USING THE PROGRAM. (THE MANUAL IS 
AVAILABLE ON THE INSTALLATION CD AND ON THE 
DRAKE SUPPORT WEBSITE: 
SUPPORT.DRAKESOFTWARE.COM > SUPPORT > 
DOCUMENTS > MANUALS.)

What’s New in Drake Tax for Partnership Returns
Drake Tax programs its tax software according to the latest IRS rules and regulations. 
The 2020 program reflects all changes to credits and deductions, including discontinu-
ations. For details on new regulations for 2020, see the IRS instructions for Form 
1065.

IMPORTANT
Be sure to review the 2020 Drake Tax User’s Manual—available from 
the Support.DrakeSoftware.com website—for details on the 
changes to the tax program and practice management tools.

The following changes have been made to the 1065 package in Drake Tax for the 
2020 tax year:

Additional 
e-Sign Fields

(For use with Drake Portals) Screens K1 and PIN have new sections designated for 
Drake Portals subscribers, so that partners can electronically sign returns. To override 
the choice of a signing partner (on screen K1), use the override fields on the PIN 
screen.
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Associating 
QBI Info.

To better associate QBI information with its corresponding forms, the QBI section at 
the bottom of screen 1 has been removed, as has the For drop list on screen 199A for 
associating QBI information. QBI relating to the main page of Form 1065 must now 
be entered on screen 199A (accessible from the Other Forms tab of the Data Entry 
Menu) instead of screen K199. Continue to use the K199 screen to report QBI infor-
mation for screens K1P and K1F.

Business 
Identity Theft

Form 14039-B, Business Identity Theft Affidavit, has been added to Drake Tax 2020.

Complete and submit Form 14039-B if the partnership suspects that it has been a vic-
tim of identity theft. 

NOTE
If the partnership never applied for an Employer Identification Num-
ber (EIN) but has begun receiving notices in its name, do not com-
plete this form. Instead, file Form 14039, Identity Theft Affidavit, 
under the Social Security Number (SSN), Individual Taxpayer Identi-
fication Number (ITIN), or Adoption Taxpayer Identification Number 
(ATIN) of the taxpayer in charge of the partnership.

Complete Form 14039-B from screen 1403 (available from the Miscellaneous tab of 
the Data Entry Menu). Forms 14039 and 14039-B are both available for printing 
from Tools > Blank Forms.

e-Filing 
Forms 7004

Multiple Forms 7004 with the same ID number can now be e-filed in Drake Tax. This 
stops “dupe” rejects for duplicate transmissions. From the 7004 screen (accessible 
from the Other Forms tab of the Data Entry Menu), select the appropriate return 
type from the Enter the form code... drop list, and calculate and file the return as nor-
mal. To file another extension, select the other form (either 1065 or 8804) from the 
same drop list, recalculate the return, and submit only the applicable Form 7004.

After transmission, each submission will appear on a separate line of the ESUM 
screen (accessible from the Miscellaneous tab of the Data Entry Menu) with the 
appropriate form code.

Global 
Autobalance 

Feature

Instead of having to turn off the autobalance feature of Schedule L for each return, 
Drake Tax has implemented a global autobalance feature that acts as a toggle, allow-
ing you to always (or never) adjust automatically the capital account on Schedule L by 
the difference between the total assets and the total liabilities and capital/equity.

For more information, see “Autobalance” on page 62.

Paycheck 
Protection 

Program 

Eligible business expenses paid by the partnership with funds from a Paycheck Pro-
tection Program (PPP) loan can now be deducted even if the loan has been forgiven.

Prior-Year 
Income 

Required

In prior years, entries on screen SEC (Filing Security Information) were optional. For 
Drake 2020, to better protect the partnership from taxpayer refund fraud, the partner-
ship’s Total prior year income amount is required. Enter this amount on screen 
SEC.
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See “Required Security Information” on page 76 for further information.

Schedule 
K-1 Codes

The IRS has discontinued page 2 of Schedule K-1 for Form 1065. The K-1 codes that 
were on page 2 are now in the Schedule K-1 instructions, but these codes can still be 
generated in Drake Tax.

Instead of producing the entire K-1 code sheet, however, Drake Tax now generates 
only those codes that actually appear on each Schedule K-1 in the partnership return. 
These codes are printed on the “Supplemental Information” page that is generated 
with each K-1, and reference the page in the K-1 instructions where further informa-
tion can be found.

For more, see “Schedule K-1 Codes” on page 50.

Tax Basis 
Required

Beginning with tax year 2020, the IRS requires all federal 1065 returns to use the tax 
basis method for reporting partners’ capital on section L of Schedule K-1; states, how-
ever, are not bound to this mandate. For this reason, Drake Tax has added two new 
sections to the PRNT screen: one for reporting alternate methods if reporting item L 
information on an applicable state’s Schedule K-1, and another for selecting other 
methods used on prior-year federal 1065 returns. If the tax basis was not used as the 
partnership’s capital method in prior years, make the appropriate selection on the 
PRNT screen, and Drake Tax adjusts the partner’s beginning capital account amount 
to the tax basis equivalent.

For additional details, navigate to “K-1 Items” on page 74.

Completing a 1065 Return in Drake Tax
The basics of data entry for a partnership (1065) return are the same as for the 1040. 
See the 2020 Drake Tax User’s Manual for the basics of using the program, or log in 
to DrakeETC.com to view online tutorials and webinars designed to teach new users 
all aspects of data entry in Drake Tax.

Updating a Prior-Year Return in Drake Tax
If you prepared a tax return in Drake Tax last year, you can update the return for the 
current year in any of the following ways:

• (recommended) As a single return (updated one at a time) using Last Year Data > 
Update Clients 2019 to 2020

• When you open the return for the first time in the 2020 program and are prompted 
to update it

• (not recommended) With all other returns in the program using Last Year Data > 
Update Clients 2019 to 2020

When you update a 1065 return that was marked as “final” the previous year, the pro-
gram informs you that the return was marked “final” before prompting you to proceed.

For more details on updating prior-year returns, see “Updating Client Files” in Chap-
ter 4 of the 2020 Drake Tax User’s Manual.
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Header Information
Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1065.

Name and Address
Use screen 1 to complete the partnership name and address section of Form 1065. For 
state purposes only, if the partnership has an alternate address (such as a P.O. box), 
you can enter it in the Address Line 2 field at the bottom of screen 2. 

Screen Code: 2 Access screen 2 from the State Info link on screen 1, from the States tab of the Data 
Entry Menu, or by entering 2 in the selector field and pressing ENTER.

“Doing
Business 

As” 

Whatever is typed into the DBA field of screen 1 is printed below the legal name of 
the partnership in the “Name” section of the main form (and on certain other forms, 
such as Schedule K-1).

Use of the DBA field is optional, and data entered there is not required by the IRS. It 
is provided in the program for the return preparer’s convenience.

The DBA can also serve as a continuation line for entity names that are too long to fit 
into the Partnership’s legal name field. Be aware, however, that not all federal forms 
accept data from a continuation (or DBA) line. For those forms, only the data entered 
in the legal name field is used.

NOTE
Not all states recognize the use of a DBA name. Those state pack-
ages ignore data entered in the DBA field.

Tax Year
The program uses the calendar year as the default period for all partnership returns. 
No date entries are required on screen 1 for partnerships with a December 31 tax year-
end.

NOTE
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.

Fiscal and 
Calendar 

Years

If the partnership uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If Not Calendar 
Year section of screen 1.

52-53-Week 
Tax Year

For information on electing a 52-53-week tax year, see “Electing a 52-53–Week Year 
(Initial Return)” on page 79.

Short-Year 
Returns

A partnership may have a short-year return if changing accounting periods with IRS 
approval (Form 3115) or if this is its first or last year in business and the tax year is not 
a full year.
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Screen Code: 
YEAR

Short-year return election information and 52-53-week tax year information is entered 
on the YEAR screen, available on the Miscellaneous tab of the Data Entry Menu or 
by clicking the Year link in the If Not Calendar Year section of screen 1.

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year beginning and Fiscal year 
ending fields, even if the firm uses the calendar year for full-year returns. (These 
dates will appear on the top of the federal form.)

2. Click the Year link (Figure 1) to open the YEAR screen. On the YEAR screen, 
make your short-year selection from the Other short-year reason drop list.

3. If you selected General Explanation from the Other short-year reason drop 
list, type details on the reasons for filing a short-year return in the Explanation 
text box. (Your explanation will be displayed at the top of the first page of the 
main form.)

For information on making elections through the ELEC screen, see “Elections” on 
page 71.

NOTE
Drake Tax may incorrectly calculate depreciation, gains, or losses for 
short-year returns. Values for these fields may be manually entered 
on screens 6, 7, 8, 9, and 4562.

For more information on short-year returns, see IRS Pub. 4163.

Boxes A through K
Most information for boxes A through K for Form 1065 is entered on screen 1. Note 
that information for boxes D (Employer identification number), F (Total assets), I 
(Number of Schedules K-1), and J (Schedule C and M-3 attached) are completed auto-
matically based on information entered elsewhere in the program. Other boxes are:

• Box A — Principal business activity
• Box B — Principal product or service
• Box C — Business code number (Press CTRL+SHIFT+S to search activity codes)
• Box E — Date business started
• Item G — Initial, final, name change, address change, or amended return
• Item H — Accounting method (Select Cash, Accrual, or Other on screen 1; if 

Other, enter a description of the method used.)

Figure 1:  Link to the YEAR screen from screen 1
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• Item K — Additional activity information (If applicable, select Aggregated activ-
ities for section 465 at-risk purposes or Grouped activities for section 469 pas-
sive activity purposes on screen 1.)

Other Information and Overrides
Use screen 1 to enter the following additional information:

• Resident State — If the partnership has a mailing address in one state but does 
business in another, use the Resident state drop list to select the state in which the 
partnership does business.

• Drake Codes and Overrides — For information on miscellaneous codes, invoice 
numbers, and override fields, see the following sections of the 2020 Drake Tax 
User’s Manual:
– “Listing a Different Firm, Preparer, or ERO on a Return,” in Chapter 2, 

“Installation & Setup.”
– “Miscellaneous Codes,” in Chapter 5, “Return Preparation.”

• Entity Name Control — Use this field only if your client has obtained a Name 
Control from the IRS.

Income and Deductions
Enter income and deductions on the INC (Income) and DED (Deductions) screens. 
INC screen amounts flow to Form 1065, page 1, lines 1a to 7. (Also see “Other 
Income (Loss)” on page 18.) Amounts from screen DED flow to Form 1065, page 1, 
lines 9 through 20.

“Other income” and “Other deductions” data is shown on attached statement work-
sheets in View/Print mode of the return.

Gross Receipts
Enter gross receipts or sales and returns and allowances on the INC screen.

NOTE
The IRS does not require a detail worksheet (CTRL+W) for gross 
receipts; therefore, if you are using the trial balance import feature, 
do not include a detail worksheet for this line.

Cost of Goods Sold (Form 1125-A)
For cost of goods sold entries, complete screen A (Form 1125-A, Cost of Goods Sold). 
Click the 1125-A link on screen INC, or select A from the General tab of the Data 
Entry Menu.

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L (Form 1065), line 3, “Inventories.” Note that the “Inventories” lines on screen L 
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(Schedule L - Balance Sheet) are override fields; inventory data entered in these fields 
override data entered in fields 1 and 7 on screen A.

Line 5, Other 
Costs

Line 5 of Form 1125-A is designated 
for any applicable costs not entered on 
the previous lines. In Drake Tax, two 
fields on screen A are provided for line 
5: one for other costs including depre-
ciation and one for other costs exclud-
ing depreciation, as seen in Figure 2.

In the Other costs - depreciation field, enter any depreciation that relates to the cost 
of goods sold (unless the amount is already entered on screen 4562 with COGS 
selected from the For drop list). Note that this field on screen A is an override field; an 
entry here overrides the calculations computed using the 4562 screen and automati-
cally adjusts the total depreciation that flows to page 1 of Form 1065. Make an entry 
in the Other costs - excluding depreciation field to open a detail worksheet 
(CTRL+W). Enter a Description and an Amount for each item. The total depreciation 
amount is broken down on a Federal Supporting Statement for Form 1065 (Schedule 5 
— Line A).

NOTE
Line 16b on the DED screen is an adjustment field for depreciation 
amounts that flow from Form 4562. No entry is required for depre-
ciation amounts that flow from screen A.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 84), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in data entry of Drake Tax. When the trial balance is imported, 
the COGS depreciation expense amount flows directly to the appropriate line of Form 
1125-A and is calculated accordingly. For more on depreciation and trial balance 
import, see “Depreciation” on page 93.

Ordinary Income (Loss)
Ordinary income or loss from other partnerships, estates, and trusts (line 4 of Form 
1065) flows from either screen K1P (Schedule K-1 from another partnership) or 
screen K1F (Schedule K-1 from a fiduciary).

Net Farm Profit (Loss)
Screen Code: F The partnership’s net farm profit or loss (line 5 of Form 1065) flows from information 

entered on screen F (Farm Income). Farm profit or loss from other partnerships, 
estates, or trusts appears on line 4 of the return. To enter this information from the 
INC screen, click either the K1P Screen or K1F Screen link beside line 4. Enter the 
farm profit or loss from other partnerships, estates, or trusts on line 1 of screen K1P or 
line 6 of screen K1F. Direct links to screens K1P and K1F are available from the 
Other Forms tab of the Data Entry Menu.

Figure 2:  Line 5 data entry fields for Form 1125-A
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For information on farming partnerships with a corporation partner, see Pub. 225, 
Farmer’s Tax Guide.

Net Gain (Loss)
The amount on line 6, “Net gain (loss) from Form 4797, Part II, line 17,” of Form 
1065 flows from screen 4797, available from the Assets-Sales-Recapture tab of the 
Data Entry Menu. Amounts can also flow from screen 4562, but only if a selection 
has been made from the Property type drop list and assets are entered in the If sold 
section. Do not duplicate amounts entered on screen 4797 with those entered on 
screen 4562.

Other Income (Loss)
Use the INC screen to enter amounts for line 7, “Other income,” of the main form. 
Specific INC screen entries are displayed on attached statements in View/Print mode 
of the return.

Amounts from the following screens also flow to line 7:

• Screen 6478 — Form 6478, Biofuel Producer Credit
• Screen 8864 — Form 8864, Biodiesel and Renewable Diesel Fuels Credit 

Additional fields on the INC screen include:

• Interest income on receivables
• Recoveries of bad debts deducted in earlier years
• Section 481 adjustments
• State tax refund (cash basis)
• Taxable income from insurance proceeds

Enter additional sources of income not listed above in the Other income (itemize) 
field. Begin typing in that field and a detail worksheet (CTRL+W) is opened with 
fields for descriptions and amounts.

Enter other income (loss) from a partnership, estate, or trust on the K1P or K1F 
screen. Access these screens by clicking the links beside line 4.

Compensation and Wages
Use the DED screen to enter wages and salaries paid—line 9 of Form 1065. Do not 
include guaranteed payments to partners or salaries or wages reported elsewhere in the 
return, such as the amounts included in COGS, elective contributions to a section 
401(k) cash or deferred arrangement, or amounts contributed under a salary reduction 
SEP agreement. Drake Tax automatically adjusts salary and wages for employment 
credits.
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Guaranteed Payments and Partner Health Insurance
Use the DED and K screens to report guaranteed payments to partners and partner 
health insurance. Note that guaranteed payments and health insurance are entered as 
separate amounts.

Guaranteed 
Payments

To report guaranteed payments to partners:

• Enter total guaranteed payments on screen DED, line 10.
– An entry on line 4a or 4b of screen K adjusts (adds to or subtracts from) the 

amounts entered on the DED screen. Guaranteed payments to partners can 
also be reported on screens RENT and 8825.

– To allocate the total guaranteed payments among the partners, click the SA 
link to the right of lines 4a and 4b on screen K. (For details on using the SA 
screen, see “Special Allocations” on page 37.)

NOTE
The amount of guaranteed payments flows to the partners’ Sched-
ule K-1 and is reported on the partner’s individual 1040 return, on 
Schedule E, line 28, column “K.”

Guaranteed payments should include any payments (or credits) to a partner for ser-
vices rendered. Include the use of any capital the partner provided if the payments (or 
credits) for that capital are not determined by the partnership’s income and can be 
allocated to a trade or business activity. These entries should not include any payments 
or credits that should be capitalized or any distributive shares of partnership profits.

Partner 
Health 

Insurance

To report partner health insurance:

• In the Partner’s health insurance field on the DED screen, line 10, enter 
amounts paid during the tax year for health insurance by a partnership on behalf of 
a partner for services as a partner (including a partner’s spouse or dependents or 
children under age 27 who are not dependents).
– An entry on line 13d, item M, Amount paid for medical insurance, on the 

Deductions tab of screen K, overrides the amount entered on the DED screen 
and the 8825 screen (Health insurance payments).

– To allocate the total amount of health insurance costs among the partners, 
click the SA link to the right of line 13d, item M, on the Deductions tab of 
screen K. (For details on using the SA screen, see “Special Allocations” on 
page 37.)

Health insurance entries flow to boxes 4 and 13 of the partners’ Schedule K-1, line 
13d of Schedule K (Form 1065), and line 10 of Form 1065.

For information on the partnership’s contribution to a partner’s Health Savings 
Account (HSA), see Notice 2005-8, 2005-4 I.R.B. 368.
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Repairs and Maintenance
Use line 11 on the DED screen to enter the costs of repairs and maintenance. See 
Form 1065 instructions for IRS requirements regarding costs that can be entered here.

Bad Debts
Use line 12 of the DED screen to enter the total of all bad debts that became worthless 
during the 2020 tax year only if these debts are related to a trade or business activity. 
Deductible non-business bad debts should be entered as short-term capital losses (with 
S selected from the Type of gain or loss drop list) on screen 8949.

NOTE
Cash-method partnerships cannot take a bad debt as a deduction 
unless the amount was previously included in income.

Rents
Use line 13 of the DED screen to enter rent paid on business property used for a trade 
or business activity. If the partnership rented or leased a vehicle, enter the total annual 
rent or lease expense incurred in the trade or business activity of the partnership, and 
then complete Part V of Form 4562 (screens 8 and 9, both accessible from the Assets-
Sales-Recapture tab of the Data Entry Menu).

Taxes and Licenses
Use line 14 of screen DED to enter tax and license payment data. Amounts entered 
here flow to the “Taxes and licenses” line of Form 1065, and to the “Wks Tax/Lic” 
worksheet in View/Print mode, and is referred to on line 14 with the literal “Wks Tax/
Lic” reference..

NOTE
Credit from Form 8846, Credit for Employer Social Security and 
Medicare Taxes Paid on Certain Employee Tips, automatically 
adjusts the amount of taxes and licenses on Form 1065.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen flow to the tax computation on the “Wks Tax/Lic” worksheet. The state tax 
amount flowing from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used and which tax type is selected.

Note that amounts entered in the fields St/City income and franchise taxes on the 
Detail screen of line 14 (screen DED) override amounts entered on the ES screen.

Interest
The “Interest” line (15) of Form 1065 refers only to the interest incurred by the part-
nership in a trade or business activity that is not claimed elsewhere in the return.
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Use line 15 of the DED screen to enter interest expense amounts. Do not include inter-
est expense on the following:

• Debt required to be allocated to the production of qualified property
• Debt used to buy rental property
• Debt used in a rental activity
• Debt used to purchase property held for investment
• Debt proceeds allocated to distributions made to partners during the tax year

Self-Charged 
Interest

Self-charged interest rules (see Form 1065 instructions) do not apply if a partnership 
elects under Reg. section 1.469-7(g) to avoid the application of them. If the partner-
ship is making this election, a statement must be included with the return.

To include the statement:

Screen Code: 
ELEC

1. Click the ELEC Screen link beside line 15 on screen DED. (The ELEC screen is 
also available from the Miscellaneous tab of the Data Entry Menu.)

2. In the Election drop list, select 19 - Not Apply Alternative Treatment to Self-
Charged Items.

When the return is calculated, the statement (“Statement EL19” in View/Print mode; 
see Figure 1), including the required text, will be included in the return.

NOTE
Use of the ELEC screen for statement purposes does not make the 
return ineligible for e-file.
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For information on self-charged interest rules, see the “Self-Charged Interest” section 
of the Form 1065 instructions.

Depreciation
Use screen 4562 to enter depreciable assets for Form 1065, Form 1125-A, Schedule F, 
Form 8825, the RENT screen (Rental Other than Real Estate), and section 754. To 
associate a depreciable asset with an activity, make a selection from the For drop list 
at the top of the 4562 screen.

Using the 
DED screen

As explained further in “Line 16, Depreciation,” following, the DED screen has two 
lines for direct entry of depreciation, both adjustment fields:

• Line 16a — Depreciation
• Line 16b — Depreciation claimed elsewhere on return

Any item entered in a depreciation field on the DED screen is added to the calcula-
tions from all 4562 screens. DED screen amounts are reflected on page 1 of Form 
1065 but are not shown on any generated Form 4562.

IMPORTANT
The depreciation fields on any screen should be used only if Form 
4562 is not required.

Figure 3: Self-charged interest statement
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For more information on depreciation and the 4562 screen, see the 2020 Drake Tax 
User’s Manual.

Line 16, 
Depreciation

Line 16 of Form 1065 is reserved for depreciation that (1) is from Form 4562 and (2) 
is claimed elsewhere. While the program pulls data from the 4562 screen for this line, 
it also provides field 16b (Figure 4) on screen DED specifically for depreciation that 
is claimed elsewhere.

Both lines 16a and 16b on the DED screen are adjustment fields and add to or sub-
tract from program calculations that are based on entries elsewhere in the program. 
Enter only the depreciation claimed on assets used in a trade or business activity.

• Line 16a — An entry here is added to the depreciation from the 4562 screens. 
The amount on line 16a is not reflected on Form 4562.

• Line 16b — Drake Tax recommends using screen A (rather than the DED 
screen) to enter depreciation claimed on Form 1125-A. An entry on line 5, Other 
costs - depreciation, of screen A adjusts any entry on line 16b of the DED screen 
and is calculated into the total deductions on Form 1065. (An entry in the Other 
costs - depreciation line on screen A also overrides calculated amounts for 
entries on 4562 screens when the For drop list is set to COGS.) If there is an entry 
on line 16b of the DED screen but not screen A, only the line 16b amount is cal-
culated into total deductions.

NOTE
Section 179 expenses do not flow to the depreciation lines (16a and 
16b) on page 1 of Form 1065; applicable expenses are reflected on 
Schedule K, “Net long-term capital gain,” and then distributed to 
each partner on Schedule K-1.

Section 754 Use screen 4562 to enter section 754 depreciation. To associate the depreciable asset 
with section 754, select 754 from the For drop list at the top of the screen.

For information on allocating Section 754 depreciation to specific partners, see “Spe-
cial Allocations” on page 37 and “Section 754 Allocations” on page 56.

Section 179 Section 179 expense is not included on Form 4562, line 22, nor is it carried to line 16a 
of Form 1065. It is instead reflected on line 12 of Schedule K (Form 1065) and distrib-
uted to each partner on Schedule K-1.

Reclassify to 
Amortization

To reclassify an asset from depreciation to amortization:

Figure 4: Depreciation line 16 fields from DED screen
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1. Open screen 4562 for the asset.
2. From the Method drop list, select AMT - Amortization.
3. Complete the applicable fields in the Amortization section of screen 4562.

Depletion
Enter depletion amounts on line 17 of the DED screen. If the partnership claims a 
deduction for timber depletion, complete and attach Form T, Forest Activities Sched-
ules, available from the IRS website. (Attach this form as a PDF document to e-filed 
returns. See “The PDF Attachment Process” on page 81.) Do not deduct depletion for 
oil and gas properties. Depletion should be figured for each partner on screen DEPL, 
accessible from the Other Forms tab of the Data Entry Menu. See “Oil and Gas 
Depletion Worksheet” on page 45 for more on entering oil and gas depletion in the 
1065 package.

NOTE
The Depletion Worksheet in the Partnership package is for informa-
tional purposes only. Depletion is calculated in the partner’s individ-
ual return.

Retirement Plans
Use line 18 on the DED screen to enter amounts for line 18, “Retirement plans, etc.” 
See the IRS instructions for guidance on what costs are acceptable for this line.

NOTE
The amount for line 18 of Form 1065 may be altered due to the 
credit amount calculated from Form 8881, Credit for Small Employer 
Pension Plan Startup Costs. Amounts for Form 8881 are entered on 
screen 8881, accessible from the Credits tab of the Data Entry 
Menu.

IRA for 
Employees

If the partnership contributes to an IRA for employees, include the contributions in 
salaries and wages on either the DED screen (line 9, Salaries and wages) or screen A 
(W-2 wages paid).

Payments to 
Partners

Do not use line 18 of the DED screen to deduct payments for partners designated for 
retirement or deferred compensation plans, IRAs, qualified plans, Simplified 
Employee Pension (SEP), or SIMPLE IRA plans. Report these amounts, which are 
deducted by the partners on their own returns, on screen K (Deductions tab), line 13d, 
item R. 

Employee Benefit Plans
Use the DED screen, line 19, to enter the partnership’s contributions to employee ben-
efits programs (such as insurance, health, and welfare programs) that are not part of a 
pension or profit-sharing plan included in line 18, Retirement plans, etc.
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Amounts 
Paid for 

Medical Care

The line 19 amount should not include amounts paid for insurance that constitutes 
medical care for a partner, a partner’s spouse, or a partner’s dependents. For informa-
tion on entering amounts paid for medical care, see “Guaranteed Payments and Part-
ner Health Insurance” on page 19.

Pub. 541 IRS Pub. 541 states that “[p]remiums for health insurance paid by a partnership on 
behalf of a partner, for services as a partner, are treated as guaranteed payments.” The 
partnership can deduct these payments as a business expense, and the partner must 
include them in gross income. The partnership cannot deduct the premiums, however, 
if the partnership accounts for insurance paid for a partner as a reduction in distribu-
tions for that partner. For instances such as this, go to the K1 screen for the partner and 
mark the Health insurance distribution reduction check box (line 13M) at the bot-
tom of the screen.

A qualifying partner can deduct 100 percent of the health insurance as an adjustment 
to income. The partner cannot deduct the premiums for any calendar month, or part of 
a month, in which he or she is eligible to participate in any subsidized health plan 
maintained by the employer of the partner or the partner’s spouse.

Other Deductions
Enter all other deductions on line 20 of the DED screen. Drake Tax calculates these 
amounts and incorporates the total into “Other deductions,” line 20, of Form 1065.

The following deductions, credits, adjustments, and exclusions also flow to the “Other 
deductions” line:

• Amortization from Form 4562, Depreciation and Amortization
• Credit adjustment from Form 6765, Credit for Increasing Research Activities
• Credit adjustment from Form 8820, Orphan Drug Credit
• Exclusion from Form 8873, Extraterritorial Income Exclusion
• Credit from Form 8941, Credit for Small Employer Health Insurance Premiums

Tax and Payments
In Drake Tax, the TAX screen, found on the General tab of the Data Entry Menu, is 
used to complete the “Tax and Payment” section of Form 1065. Payment of the tax 
depends on which line the tax is reported. Depending on the type of tax and the 
required payment, it is possible that the partnership may have to write separate checks 
to remit payment since there are separate form attachments, payment types, and 
addresses listed for the different lines. There are no estimated payment requirements 
at this time.

Use the TAX screen to report the following Form 1065 data:

• Line 23 — “Interest due under the look-back method – completed long-term con-
tracts”: Data entered on line 23 adjusts an amount flowing from Form 8697, Inter-
est Computation Under the Look-Back Method for Completed Long-Term 
Contracts.
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NOTE
Form 8697 is used to figure the interest due or to be refunded 
under the look-back method of section 460(b)(2) on certain long-
term contracts that are accounted for under either the percentage 
of completion method or the percentage of completion-capitalized 
cost method.

Click the 8697 link on screen TAX to complete and generate Form 8697. Drake 
Tax e-files Form 8697 with the 1065 return unless there is a refund of interest paid 
on certain long-term contracts or if the form is being filed separately with a pay-
ment, in which case the form must be signed and then mailed.

– If a refund is due, select the Mark this box if filing this form separately 
check box on screen 8697, print the form, and after having it signed, mail it.

– If making a payment of interest due, select the Mark this box if filing this 
form separately check box on screen 8697, print and sign the form, then mail 
the form with a check or money order for the full amount, made payable to 
“United States Treasury.” Write the partnership’s Employer Identification 
Number (EIN), daytime phone number, and “Form 8697 Interest” on the 
check or money order.

• Line 24 — “Interest due under the look-back method - income forecast method”: 
Form 8866, Interest Computation Under the Look-Back Method for Property 
Depreciated Under the Income Forecast Method, is used to figure the interest due 
or to be refunded under the look-back method of section 167(g)(2) for property 
placed in service after September 13, 1995 that is depreciated under the income 
forecast method as described in section 167(g).
Data entered on line 24 of the TAX screen adjusts an amount flowing from Form 
8866. To complete the form, click the 8866 link on screen TAX. Drake Tax e-files 
Form 8866 with the 1065 return unless there is a refund of interest paid or if the 
form is being filed separately with a payment, in which case the form must be 
signed and then mailed.

– If a refund is due, select the Mark this box if filing this form separately 
check box on screen 8866, print the form, and after having it signed, mail it.

– If making a payment of interest due, select the Mark this box if filing this 
form separately check box on screen 8866, print and sign the form, then mail 
the form with a check or money order for the full amount, made payable to 
“United States Treasury.” Write the partnership’s Employer Identification 
Number (EIN), daytime phone number, and “Form 8866 Interest” on the 
check or money order.

• Line 25 — “BBAAAR imputed underpayment”: Use this line if the partnership is 
filing an AAR electronically and chooses to pay the imputed underpayment. For 
instructions on how to figure the imputed underpayment, see the Instructions for 
Form 8082.
Write the name of the partnership, the tax identification number, tax year, “Form 
1065,” and “BBA AAR Imputed Underpayment” on the check. Checks must be 
payable to “United States Treasury” and mailed to:
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Ogden Service Center
Ogden, UT 84201-0011

Payments can also be made electronically.

• Line 26 — “Other taxes”: In a few rare instances, payments other than those listed 
above may have to be made with Form 1065. Enter a description of these pay-
ments and the amounts being paid in the Description text boxes on line 26 of 
screen TAX. In View/Print mode, “Statement TAX” lists these other taxes.

• Line 28 — “Payment”: Enter on this line any prepayments related to lines 23-26 
above. Data entered here adjusts an amount entered on the 7004 screen for pay-
ments made with the extension.

Filing an Extension
Generally, a domestic partnership must file Form 1065 by the fifteenth day of the third 
month following the date its tax year ended as shown at the top of Form 1065.

Calendar-year returns are due on March 15, 2021. By filing Form 7004, a partnership 
can extend the deadline six months to September 15, 2021. Fiscal-year returns are due 
on the fifteenth day of the third month after the end of the fiscal year.

To file a 1065 extension, use one of the following options:

• Go to the 7004 screen (Other Forms tab of the Data Entry Menu) and select 
Generate an extension. Complete any other applicable fields on the screen.

• Go to the PRNT screen (Miscellaneous tab of the Data Entry Menu) and select 
Prepare a Form 7004 extension, located under the Other Return Options sec-
tion.

Signing the Return
PIN signatures are required for e-filed returns. To e-file a return, complete all fields on 
the PIN screen, accessed from the General tab of the Data Entry Menu. A return 
cannot be e-filed if the PIN screen is not completed, including the Title and Signa-
ture (name) fields for the general partner or LLC member manager. (See “‘Signs 
Return’ Partner,” following.) A Signature date and SSN of the signing person is also 
required.

“Signs 
Return” 
Partner

If the Signs Return check box was selected for one of the partners on a K1 screen, 
entries for that partner’s ID number, Title for Pin Signature, Name, and Phone 
number on screen K1 will be included with the ERO PIN, Partner PIN, and Signa-
ture date entries on the PIN screen—the ERO PIN, Partner PIN, and Signature 
date must still be entered on the PIN screen in order to e-file the return. If the Signs 
Return check box is not marked on any K1 screen, then the ERO PIN, Partner PIN, 
Signature date, Title, and Signature fields on the PIN screen must be completed 
manually.

Preparer’s 
Signature

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided on the PIN screen. If the return 
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is prepared by a partner or an employee of the partnership, open screen 1 and select 
NONE from the Firm # and Preparer # drop lists.

To have the preparer’s signature displayed on the printed return:

• If the return preparer and ERO (entered in Setup > Electronic Filing & Account 
Information (ERO)) are the same:
– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-

ture box is marked for the preparer.
– Enter the preparer’s PIN on the PIN screen for the return.

• If the return preparer and ERO are not the same, go to the PRNT screen and com-
plete the field labeled PIN for preparer’s alternative electronic signature. The 
PIN entered should match the one entered for the preparer in Setup > Pre-
parer(s).

IMPORTANT
Setup > Electronic Filing & Account Information (ERO) must be 
completed in Drake Tax in order to e-file returns. For information on 
how to complete this setup window, see 2020 Drake Tax User’s Man-
ual. See the IRS instructions for further details on signature require-
ments.

The optional Suffix drop list and Professional text box on the PIN screen allow you 
to add such designations as “Jr.,”“Sr.,” and “III” to the name of the partner, as well as 
such professional designations as “Dr.” or “Ret.”

Form 
8879-PE

You must receive the completed and signed Form 8879-PE, IRS e-file Signature 
Authorization for Form 1065, before the return is e-filed. This form must be kept in 
the tax office for three years from the return due date or IRS received date, whichever 
is later.

To generate the filing instructions for Form 8879-PE, do one of the following:

• From the Home window of Drake Tax, go to Setup > Options > Client Commu-
nications tab, and set the program to print the filing instructions for all returns by 
selecting Always print from the Federal (and State, if desired) drop list under 
the section Filing Instructions.
– Alternately, mark the check box Print filing instructions for federal Forms 

8878 and 8879 if you want only federal e-file authorization instructions to be 
printed.

• With an open return, from the PIN screen select Yes from the Print filing 
instructions for Form 8879 drop list. The instructions will be printed for the cur-
rent return only; use this method to print instructions on a per-return basis.

For information on using an electronic signature pad to digitally sign Form 8879-PE, 
see “Electronic Signatures” in Chapter 6, “Return Results,” of the 2020 Drake Tax 
User’s Manual.
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Amending a Return

CAUTION
When you amend a return in Drake Tax, the amended information 
replaces the original in the data file. Before amending a return, you 
should archive the original to avoid losing previously submitted 
data.

For more information on archiving returns, see “Archive Manager” in 
Chapter 6, “Return Results,” of the 2020 Drake Tax User’s Manual.

To file a 1065 return that has been amended:

1. Go to screen 1 in data entry, and select Amended return in section G.
2. Make changes as applicable to forms and schedules.
3. Go to the EF screen and select Amended 1065 in the left-hand column.
4. Go to the SCH screen (available from the Miscellaneous tab of the Data Entry 

Menu) and complete the following fields:
• Statement number — Select 011 - Amended Return Statement.

• Title — Enter a statement title of 28 or fewer characters.

• Explanation text box — Identify the amended items by line number and 
explain what was changed and why. 

If amending just the K-1s, go to each K1 screen, select Amended K1 in the upper-
right corner, and make the necessary changes.

NOTE
When amending a 1065 return, all K-1s are amended, and the 
“Amended K-1” box on the return is marked automatically. To over-
ride this default, go to the PRNT screen, and mark Do NOT check 
amended box on Sch. K-1.

TEFRA and Filing Eligibility
A partnership subject to the TEFRA (Tax Equity and Fiscal Responsibility Act of 
1982) audit rules cannot file an amended Form 1065 to correct a partnership item 
reported on a previously filed return, but according to these rules, the partnership rep-
resentative (PR) must file Form 8082, Notice of Inconsistent Treatment or Adminis-
trative Adjustment Request, on the partnership’s behalf and request the IRS treat the 
Form 8082 as a substituted return. 

A partnership qualifying as a small partnership (see Section 6231(a)(1)(B))—with 10 
or fewer partners at any one time during the year—is exempt from the TEFRA audit 
rules and can file an amended Form 1065 and corrected K-1s to partners.
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Additional Information
This section covers Schedule B, “Other Information,” state-specific information, and 
some program overrides.

NOTE
If an entity and not an individual is selected as the partnership rep-
resentative on a K1 screen, additional data is required in the Desig-
nation of Partnership Representative section of screen B 
(Schedule B, cont. tab). 

Schedules B, B-1, and B-2
The program has five screens for entering data for Schedule B (Form 1065), Other 
Information, Schedule B-1 (Form 1065), Information on Partners Owning 50% or 
More of the Partnership, and Schedule B-2 (Form 1060), Election Out of the Central-
ized Partnership Audit Regime. Data entry for the above form and schedules is sepa-
rated into several screens and entered in the following locations:

• Screen B (Schedule B tab) — For lines 1 through 20 (excepting lines 2 and 3)
• Screen B (Schedule B, cont. tab) — For lines 21 through 28 (excepting line 26)
• Screen B1 — For lines 2a and 2b of Schedule B-1 (foreign ownership of the part-

nership). Much of the data on Schedule B-1 flows from entries on each partner’s 
K1 screen. See “Schedule B-1 Information” on page 30.

• Screen B2 — For Schedule B-2: electing out of an audit regime and listing share-
holders in an S corporation that is a partner in the partnership. See “Electing Out 
of Centralized Partnership Audit Regime” on page 33.

• Screen B3 — For lines 3a and 3b of Schedule B (ownership of foreign companies 
by the partnership).

From screen B, you can access screens B1 and B3 by clicking the applicable links 
(Schedule B1 and Attachment 3a and 3b) or by pressing PAGE DOWN twice (for 
screen B1) or three times (for screen B3).

Schedule B-1 Information
Enter the required Schedule B-1 information—Type of Partner, Country of Incor-
poration/Organization, and Max Percentage Owned in Profit, Loss, or Capital—on 
each partner’s K1 screen. (This information can also be entered on the B1 screen.)

When you make a selection from the Country of Incorporation/Organization drop 
list in the Schedule B-1 section of a K1 screen (Figure 5) and then make an entry in 
the Max Percentage Owned field, the program automatically answers questions 2a 
and 2b of Schedule B and produces Schedule B-1, using the information entered on 
the K1 screen—Name, ID number, Type of Partner—to complete Parts I or II (as 
appropriate).
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Of course, you can continue to use the B1 screen if you prefer.

Foreign 
Ownership

If the partnership owned (directly) an interest of 20 percent or more or owned (directly 
or indirectly) 50 percent or more of the total voting power of all classes of stock enti-
tled to vote of any foreign or domestic corporation, use the Line 3a section of screen 
B3 to enter the Name of Corporation, EIN, Country of Incorporation, and Per-
centage Owned in Voting Stock. (From the B screen, click the Attachment 3a and 
3b link beside line 3, or click B3 from the Data Entry Menu.)

Screen Code: B3 If the partnership owned (directly) an interest of 20 percent or more or owned (directly 
or indirectly) an interest of 50 percent or more in profit, loss, or capital in any foreign 
or domestic partnership or in the beneficial interest of a trust, use the Line 3b section 
of screen B3 to enter the Name of Entity, EIN, Type of Entity, Country of Organi-
zation, and Maximum Percentage owned in Profit, Loss, or Capital.

NOTE
Which screens are required depends on the percentage owned. See 
Form 1065 instructions for calculating the maximum percentage 
owned.

Line 4 
Require-

ments

If question 4, Does partnership meet all requirements listed for question 4 of 
Form 1065, on screen B is answered Yes, Schedules L, M-1, M-2, and Section L of 
Schedule K-1 are not required and therefore not printed. The four conditions that must 
be met in order to answer Yes to this question are:

• The partnership’s total receipts for the tax year were less than $250,000.
• The partnership’s total assets at the end of the tax year were less than $1,000,000.
• Schedules K-1 are filed with the return and furnished to the partners on or before 

the due date (including extensions) for the partnership return.
• The partnership is not filing and is not required to file Schedule M-3.

The 4c check box on screen B allows you to indicate that the Schedules K-1 were not 
furnished to the partners on or before the due date of the partnership return while 
answering “Yes” to the other three parts.

For more on line 4, see “Schedule L (Balance Sheets Per Books)” on page 58.

Figure 5: Entering the circled questions on screen K1 produces Schedule B-1 
automatically
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Partnership Representative
Partnerships must appoint a “partnership representative.” The partnership representa-
tive (PR) does not have to be a partner in the partnership but does have to possess a 
U.S. taxpayer ID number (TIN), and the address of the representative must be a U.S. 
address. A PR is indicated by marking the PTR REP check box (Figure 6) on the 
appropriate K1 screen, or by completing the Designation of Partnership Represen-
tative section on the Schedule B, cont. tab of screen B. The representative’s informa-
tion is printed at the bottom of page 3 of Form 1065.

The PR has “complete authority to act on behalf of the partnership” when dealing with 
the IRS. This includes legally binding the partnership (and therefore, the partners) in 
terms of audits and other IRS proceedings.

The Drake Tax program does not select a PR if one is not indicated on screen 
K1 or the Schedule B, cont. tab of screen B. An EF Message is generated, stopping 
e-file until a selection of a representative is made.

The same is true if more than one partner is indicated as the PR. An EF Message stops 
e-file until a single selection is made.

Any information entered in the override fields of the Designation of Partnership 
Representative section of the Schedule B, cont. tab of screen B overrides the PR 
election made on a screen K1.

NOTES
• If an entity and not an individual is selected as the Partnership 
Representative on a K1 screen, additional data will be required in 
the Designation of Partnership Representative section of the 
Schedule B, cont. tab of screen B.

• To change or revoke a previously selected partnership represen-
tative, the partnership must file Form 8979, Partnership Representa-
tive Revocation, Designation, and Resignation Form. Drake Tax does 
not generate this form with the return; it must be downloaded from 
the IRS website, printed, completed, and attached to the return as a 
PDF. To learn how to upload and attach documents to a return, see 
“PDF Attachments” on page 81.

Figure 6: Designating a partnership representative on screen K1
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Reporting Limitation on Business Interest Expense
Every taxpayer who deducts business interest is required to file Form 8990, Limitation 
on Business Interest Expense Under Section 163(j), unless an exception for filing is 
met. Form 8990 is used to figure the amount of business interest expense the partner-
ship can deduct and the amount to be carried forward to the next year.

Screen code: 
8990

If any of the criteria listed on line 24 of screen B (Schedule B, cont. tab) is met, mark 
the Yes check box on that line, then go to screen 8990, available through the Other 
Forms tab of the Data Entry Menu.

A partnership is not required to file if it is a “small business taxpayer” and does not 
have excess business interest expense from another partnership. The partnership is 
also not required to file Form 8990 if it has only interest expense from these excepted 
trades or businesses:

• The trade or business of providing services as an employee
• An electing real property trade or business
• An electing farming business
• Certain utility business

A “small business taxpayer” is a taxpayer that is not a tax shelter and has average 
annual gross receipts of $26 million or less for the three prior tax years under the gross 
receipts test.

Before entering data in the fields on screen 8990, enter data on all other screens 
needed to complete Form 1065. View the return (press CTRL+V), and note “Ordinary 
business income (loss)” on page 1, line 22 of Form 1065, then return to this screen and 
enter the taxable amount on line 6, Taxable Income, and complete all other applica-
ble fields. 

Electing Out of Centralized Partnership Audit Regime
Question 25 of Schedule B (available on the Schedule B, cont. tab) asks if the part-
nership is electing out of the centralized partnership audit regime. If the answer is Yes, 
then Drake Tax generates Schedule B-2, Election Out of the Centralized Partnership 
Audit Regime, listing all partners in the partnership based on the information provided 
on the K1 screens in the program. (If any of these partners is a partnership, however, 
or if the partnership has more than 100 partners, the partnership cannot elect out of the 
centralized partnership audit regime and is ineligible to use Schedule B-2.)

Screen Code: B2 If a partner in the partnership is an S corporation, all the shareholders of that corpora-
tion must be included in Part II of Schedule B-2. Those shareholders’ names, ID num-
bers, and their “type” must be entered on the Schedule B-2 screen (available via the 
link Sch B-2 on the Schedule B, cont. tab or from the General tab of the Data Entry 
Menu). Each of these shareholders count as a partner toward the 100-partner limit for 
the eligibility to elect out of the audit regime and eligibility to use Schedule B-2.

If the answer to question 25 is “No,” Drake Tax completes the “Designation of Part-
nership Representative” section at the bottom of Schedule B automatically, based on 
the K1 screens included in the return. (Information on the partnership representative 
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also can be entered on the Schedule B, cont. tab of screen B in the Designation of 
Partnership Representative section.)

Forms 8996 and 8997, Qualified Opportunity Funds
Section 1400Z-2 provides partners investing eligible gains in Qualified Opportunity 
Funds (QOF) the option to “defer recognition of certain gains.”

Form 8996 In Drake Tax, click the 8996 link on line 26 of screen B (Schedule B, cont. tab) to 
access screen 8996 to complete Form 8996, Qualified Opportunity Fund. The partner-
ship files Form 8996 annually to report that the QOF meets the investment standard of 
section 1400Z-2 or to figure the penalty if it fails to meet the investment standard.

Screen code: 8996 See Form 8996 and its related instructions for more information.

Form 8997 An investor in a qualified opportunity fund uses Form 8997, Initial and Annual State-
ment of Qualified Opportunity Fund (QOF) Investments, to inform the IRS of the 
QOF investments and deferred gains held at the beginning and end of the current tax 
year, as well as any capital gains deferred and invested in a QOF and QOF invest-
ments disposed of during the current tax year.

Eligible 
Foreign 

Entity

If the partner is an eligible foreign entity, one that would be treated as a C corporation 
(1120) were it a domestic entity, select the B2 - Eligible foreign entity check box in 
the Type of Partner section of screen K1. The partner will be labeled with the correct 
code in the “Type of Eligible Partner” column of Schedule B-2, Election Out of the 
Centralized Partnership Audit Regime.

Form 8832, Entity Classification Election
Form 8832, Entity Classification Election, is used by a business entity to elect how it 
will be classified for federal tax purposes—as a corporation, a partnership, or an entity 
disregarded as separate from its owner. An eligible entity is classified for federal tax 
purposes under the default rules unless it files Form 8832 or Form 2553, Election by a 
Small Business Corporation. The IRS uses the information entered on this form to 
establish the entity’s filing and reporting requirements for federal tax purposes.

Screen code: 8832 In Drake Tax, screen 8832 is available on the Other Forms tab of the Data Entry 
Menu.

State-Specific Information

Resident 
State

The program automatically generates a return for the partnership’s resident state. Use 
screen 2 (accessible from the States tab of the Data Entry Menu) to enter company 
information as it should appear on the state return.

NOTE
The company information fields on screen 2 apply to the resident 
state only.
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Company information on screen 2 includes the type of return that applies for state pur-
poses (consolidated, composite, controlled group, multi-state) and state-specific dates 
and numbers for identification.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 for the alternative data for Registered Office, Principal 
Place of Business, “Books in care of,” and general Contact Information for the 
partnership’s contact person.

Other States Data for other states must be entered in state data entry. To access state data entry, 
select the States tab from the Data Entry Menu and select the desired states for 
state-specific screens (or type the two-letter state code in the selector field and press 
ENTER).

Multi-State 
Appor-

tionment

Enter sales, payroll, and property factors on the APPT (Multi-State Apportionment) 
screen, accessible from the States tab. This screen (Figure 7 on page 35) provides one 
central location for entering all state apportionment information instead of having to 
open each needed state’s screen.

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet (“Wks SA-SUM”) that can be used for verifying input, 
and a reconciliation worksheet (“Wks SA-REC”) that ties the total of the state 
amounts to the federal return figures. These worksheets are available in View/Print 
mode.

Individual state apportionment screens are still available in Drake20; however, entries 
on these screens override state data entered on the APPT screen.

TIP
Mark the Zero Apportionment check box (Figure 7) to add a state 
but not include any apportionment data. This will include the state 

Figure 7: APPT (Multi-State Apportionment) screen
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on the apportionment summary worksheet (“Wks SA-SUM”), avail-
able through View/Print mode.

APPT Screens The APPT screen is opened to the Sales tab. Links at the top of this screen take you to 
the Payroll, Property, and Additional Property tabs for each state selected 
(Figure 7). These screens and their uses are listed in Table 1.

NOTE
The Ending amount entered on the Property and Additional 
Property tabs in 2019 becomes the Beginning amount when the 
client’s return is updated in Drake20.

You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT - Other Reconciliation from the State Selection drop list on the Sales tab 
when using the reconciliation worksheet. As not every item appearing on the federal 
return may be subject to multi-state apportionment, when you select OT, the data 
entered becomes a reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information flows to that state’s return.

Schedule K (Partners’ Distributive Share Items)
Use the K screens to enter data for Schedule K (Form 1065), Partners’ Distributive 
Share Items. 

NOTE
The screen K fields are primarily adjustment fields. Press F1 in a field 
to see what amounts are adjusted from elsewhere in the program.

Table 1: APPT Screens 

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter guaranteed payments to partners, salary, wage, com-
mission, labor, and repairs amounts for each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, and select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists
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Screen K is a “tabbed” screen with separate tabs (circled in Figure 8 on page 37) for 
data entry of Income (Loss), Deductions, Credits, AMT and basis, and Other Infor-
mation. There is also a tab for Analysis of Net Income.

Each of the tabs includes “Other” items such as “Other” income and “Other” deduc-
tions, etc., allowing a detailed supplemental K-1 statement (Figure 9). This statement 
is attached to the partner’s Schedule K-1.

Special 
Allocations

Override the calculated amounts of Schedule K items on the SA (Special Allocation) 
screen, reached by clicking the applicable SA link on screen K. Override the alloca-
tion of any of the items on screen K for any of the listed partners.

For example, in Figure 10 on page 38, the calculated allocation to the partners of 
Ordinary dividends (line 6a of screen K, item #1) of $123,342, is being overridden 
by Dollar Amount (#2). As the allocations are entered in the Dollar Amount column, 
the program shows the Percentage of the total that equals the dollar amount allocated 

Figure 8: Screen K is tabbed (tabs circled at the top of the screen)

Figure 9: Detailed statements with Schedule K “Other” items
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(#3). The program also keeps a running total of the allocated amounts and the amounts 
yet to be allocated (#4). To change from allocation by dollar amount to allocation by 
percentages, select Percentage (#5).

NOTES
• When the return is calculated, any amounts remaining unallo-
cated is allocated to the partners based on pro rata calculations of 
partners’ percentage as entered on screen K1. Enter “0” (zero) in the 
Max Percentage Owned field on screen K1 to remove the selected 
partner from the pro rata distribution calculation.

• Section L, “Partner’s Capital Account Analysis,” of the Schedules 
K-1 is recalculated based on the overrides entered on the SA screen.

When you click an SA link from screens 199A, K, L, 
M1, M2, M32, or M33 to make a special allocation, 
and enter an amount or percentage on that SA screen, 
the screen link on the original 199A, K, L, M1, M2, 
M32, or M33 screen changes color (Figure 11), mak-
ing it easier to find those items that have been over-
ridden.

The “Other increase (decrease)” field of Section L of 
the Schedules K-1 will be recalculated based on the 
overrides entered on the SA screen to reconcile the 
ending capital.

For more on the “Other” fields of screen M1, see 
“‘Other’ Adjustments” on page 63.

Partners’ 
Capital 

Analysis

From screen M2, click and use an SA link to reconcile Schedule M-2 (Form 1065), 
Analysis of Partners’ Capital Accounts, to the “Partner’s Capital Account Analysis” 
in section L of Schedule K-1.

Figure 10: Special Allocations (SA) screen

Figure 11: SA links change 
color when entries have been 

made on the SA screen
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Property 
Distributions

There is also a link to screen SA on both screen 8825 and RENT to allow allocation of 
property or real estate rental income.

3468 
Amounts

The Special Partner Allocations for 3468 Amounts link at the top-right corner of 
screen 3468 opens screen Schedule K Line 20C for Form 3468, allowing you to allo-
cate investment credit amounts from Form 3468 to the partners.

NOTES
• Do not use SA screens for entering amounts on Schedule K.

• SA screens cannot be used for any Schedule K line with a zero 
(“0”) balance.

Passing Through QBI Information
For tax years beginning after 2017, individuals, estates, and trusts that are partners in a 
partnership may be entitled to a deduction of up to 20 percent of their Qualified Busi-
ness Income (QBI) from a trade or business, plus 20 percent of qualified Real Estate 
Investment Trust (REIT) dividends and qualified Publicly Traded Partnership (PTP) 
income. The deduction is subject to multiple limitations (such as the type of trade or 
business, the taxpayer’s taxable income, the amount of W-2 wages paid with respect 
to the trade or business, and the unadjusted basis immediately after acquisition of 
qualified property held by the trade or business) and can be taken in addition to the 
standard or itemized deductions.

Partnerships are not eligible for the QBI deduction; instead, they must pass the neces-
sary information through to their partners. The IRS requires that all partners taking a 
section 199A deduction attach a statement, identifying each trade or business with a 
breakdown in cost of said deductions. Drake Tax automatically produces this state-
ment for each partner, known as Statement A - QBI Pass-through Entity Reporting 
(“K-1 Wks QBI” in View/Print mode).

So that you can report the above information, Drake Tax has included in the 1065 
package screens 199A and K199; use screen 199A to associate QBI information with 
Form 1065 or screen K199 to tie QBI data with screens K1P or K1F. Any data 
entered on screen 199A flows to the Qualified Business Income Information (QBI) 
worksheet, where screen 199A data is compared to the program-calculated QBI 
amounts—be sure to mark the Check this box to override 1065 main form amounts 
box to have screen 199A amounts calculate QBI instead. There are also the Qualified 
Business Income (QBI) sections on screens F, RENT, and 8825. Drake Tax automat-
ically produces the required statements with each partner’s Schedule K-1.

IMPORTANT
• The program assumes that the partnership operates as a single 
business entity and that all of the income on Form 1065, line 22, 
“Ordinary business income (loss),” is Qualified Business Income for 
purposes of computing QBI deductions. If the amount on line 22 is 
from more than one trade or business, multiple screens 199A must 
be created (one for each trade or business), and amounts must be 
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entered accordingly. If the program’s calculated QBI total and the 
screens’ 199A total differ, the preparer will be instructed to create 
an N199 screen to confirm the differences.

• To indicate that the partnership is a publicly traded partnership 
(PTP), from screen B, select the Yes box beside line 5.

• Should unadjusted basis in assets (UBIA) need to be applied to 
the QBI calculation, Drake Tax will take the data entered on screen 
4562 and use it accordingly. If you would like to calculate the tax-
payer’s UBIA outside of Drake tax, report UBIA on screen 199A in 
the Section 199A Unadjusted basis of assets allocated to this 
activity field.

Denoting Specified Service Trades or Businesses
Specified service trades or businesses are generally excluded from the definition of 
qualified trade or business. If the partnership is a Specified Service Trade or Business 
(SSTB), the partner could be subject to income limitations mentioned earlier; you 
must, therefore, mark the Treat as a “specified service business” box on the appro-
priate screen 199A or K199, if applicable.

A specified service trade or business is any trade or business providing services in the 
fields of **:

** Any trade or business where the taxpayer receives fees, compensation, or other income 
for endorsing products or services, for the use of the taxpayer's image, likeness, name, sig-
nature, voice, trademark, or any other symbols associated with the taxpayer's identity, or for 
appearing at an event or on radio, television, or another media format 

Reporting Section 199A Items

IMPORTANT
New for 2020: Data entry pertaining to QBI information has 
changed with the intent of making it easier to discern where to 
associate QBI information; among these changes, certain QBI 
deductions are now entered on screens different from what has 
been used in previous years. Read the following sections carefully to 
ensure that data is entered in the correct locations.

Report the Section 199A items to be passed through to the partners on screen K199, 
Qualified Business Income. Select from the For drop list the screen (K1P or K1F) 
that this activity pertains to.

•   Health •   Law •   Accounting

•   Actuarial science •   Performing arts •   Consulting

•   Athletics •   Financial services •   Brokerage services
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Other QBI information should be reported on the following screens, as applicable:

• QBI is relevant to a single active trade or business only, reported on line 1 of 
Schedule K; or, QBI is from multiple business activities classified as “Ordinary 
business income” on line 1 of Schedule K — Screen 199A

• Farms — Screen F
• Rental real estate — Screen 8825
• Rentals other than real estate — Screen RENT

On each screen K199 (Figure 12), type in the EIN and name of the business, and be 
sure to mark the Treat as a “specified service business” check box where appropri-
ate. Type the Section 199A income information in the appropriate fields. To allocate 
the amounts and activities to the various partners, click the SA links. If reporting 
income data from more than one trade or business, press PAGE DOWN for an additional 
screen in order to allocate the data among the separate trades or businesses.

For screens 8825, RENT, and F, select Yes or No from the This activity is a trade or 
business drop list in the Qualified Business Income (QBI) section at the bottom of 
the screen. (If this return was updated from Drake Tax 2019, the field should be com-
pleted for you.)

NOTE
If Form 1065 is filed with no Section 199A information in box 20 
(code Z) of Schedule K-1, the IRS will assume that no QBI data was 
generated from this partnership and will not allow the QBI deduc-
tion on the partner’s individual return.

Safe Harbor for Rental Properties
A rental real estate enterprise can be treated as a trade or business for purposes of sec-
tion 199A deduction. To qualify for this safe harbor, the enterprise must meet several 
requirements, among them:

Figure 12: Qualified Business Income Deduction fields on screen K199
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• For rental real estate enterprises that have been in existence less than four years, 
250 or more hours of rental services are performed per year. For other rental real 
estate enterprises, 250 or more hours of rental services are performed in at least 
three of the past five years

• Separate books and records are maintained to reflect income and expenses for 
each rental real estate enterprise

• The taxpayer maintains contemporaneous records, including time reports, logs, or 
similar documents, regarding the following: hours of all services performed, 
description of all services performed, dates on which those services were per-
formed, and who performed the services

Commercial and residential real estate may not be part of the same enterprise for pur-
poses of meeting this safe harbor.

Open screen 8825 for each rental property. In the Qualified Business Income (QBI) 
section at the bottom of the screen, select Y from the This activity is a trade or busi-
ness drop list, and make the appropriate selection from the Rental real estate enter-
prise meets “safe harbor”... drop list. The program produces the Rental Real Estate 
Safe Harbor worksheet (“QBI Safe Harbor” in View/Print mode).

If a rental doesn’t qualify for the Safe Harbor, it might still qualify for the 199A 
deduction.

For complete details, see IRS Notice 2019-07.

QBI Statements
Drake Tax includes the following worksheets with 1065 returns that include Qualified 
Business Income:

• The “Statement A – QBI Pass-through Entity Reporting” worksheet that includes 
Section 199A items, is attached to and filed with Schedules K-1. The “Qualified 
Business Income Information” worksheet—a summary of Statement A—is also 
generated with the return. (This second worksheet will not be filed and is for 
record-keeping purposes only.)

• “Statement B – QBI Pass-through Entity Aggregation Elections” is attached to 
and filed with Schedule K-1. A “Qualified Business Income Aggregation” work-
sheet—a summary of Statement B—is generated for the entity’s records.

• “Statement C – QBI Pass-through Entity Reporting” is attached to and filed with 
Schedule K-1 for patrons of specified agricultural and horticultural cooperatives.

See IRS instructions for more on these statements.

Aggregation, BAN, and PBAN
A partnership engaged in more than one trade or business may choose to “aggregate” 
(combine) multiple trades or businesses into a single trade or business for QBI pur-
poses. In Drake Tax, use the Business Aggregation Number (BAN) fields to put these 
businesses together into one group or “aggregation.”



Drake Software User’s Manual - Partnerships (1065)

Tax Year 2020                                                                                               43 

 
IMPORTANT
Once a partnership aggregates a group of trades or businesses, the 
individual partners must abide by that aggregation. If the partners 
wish to choose their own aggregations, use the “Potential” Business 
Aggregation Number (PBAN) instead of the BAN. See “PBANs,” 
below, for more information.

If the partnership is engaged in more than one trade or business, and you determine 
that some of the separate businesses that are reported on this tax return qualify for 
aggregation, and the partnership wants to aggregate them, then enter the same number 
in the BAN fields of the different businesses on the screen for which QBI information 
is entered (screen K199, 199A, RENT, etc.).

Screen Code: 
BAN

Next, complete screen BAN (available on the Other Forms tab of the Data Entry 
Menu) for each of the trades or businesses being aggregated. Use the same BAN for 
the BAN screen as on the other screens of this aggregation. Name the aggregated 
group, and provide an explanation of the factors met that allow the aggregation in 
accordance with Regulations section 1.199A-4.

BAN 
Require-

ments

Multiple trades or businesses can be aggregated into a single trade or business if they 
meet the following requirements:

• The taxpayer or a group of persons directly or indirectly own 50 percent or more 
of each trade or business for a majority of the tax year, and all trades or businesses 
use the same tax year end.

• None of the trades or businesses is a specified service trade or business.
• The trades or businesses meet at least two of the following factors:

– They provide products or services that are the same or that are customarily 
offered together.

– They share facilities or share significant centralized business elements such as 
personnel, accounting, legal, manufacturing, purchasing, human resources, or 
information technology resources.

– They are operated in coordination with, or reliance upon, one or more of the 
businesses in the aggregated group.

If there has been any change on the aggregation since the partnership’s 2019 return, 
then, in text box 2 of the BAN screen, describe any changes in facts or circumstances 
that have occurred since the prior year relating to an existing aggregation of the trade 
or business.

PBANs On their Individual (1040) returns, partners have the choice to “aggregate” (or com-
bine) certain businesses into one entity for purposes of computing the Qualified Busi-
ness Income deduction (QBID). For that to happen, the partnership must tell the 
partners which trades or businesses qualify to be aggregated. This is done by using the 
PBAN fields.

If this partnership qualifies to be aggregated with any other businesses on this 1065 
return but would like to leave aggregation choices up to the partners, enter a number 
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in the PBAN field (see Figure 13) on the screen for which QBI information is entered 
(screen K199, 199A, RENT, etc.).

Enter this same number in the PBAN fields of every appropriate screen for each busi-
ness on this return that potentially could be aggregated. (See “Reporting Section 199A 
Items” on page 40.) In Figure 13 (screen K199), this trade has been aggregated with 
others using PBAN “2.”

Screen Code: 
PBAN

Complete screen PBAN (available on the Other Forms tab of the Data Entry Menu) 
for each of the trades or businesses suggested for aggregation. Enter the proper PBAN 
and provide an explanation of the factors met that allow the aggregation in accordance 
with Regulations section 1.199A-4 (see “BAN Requirements” on page 43). Use the 
same PBAN for the PBAN screen as on the other screens of this aggregation.

Screen Code: 
N199

If any portion of the income or loss calculated on line 22, “Ordinary business income 
(loss),” of Form 1065 is not trade or business income for QBI deduction purposes, 
open screen N199 (available from the Other Forms tab of the Data Entry Menu), 
and allocate the portion of the item that should not be included on Schedule K-1, box 
20, code Z.

Statement B, QBI Pass-Through Entity Aggregation Election(s) (listed as “K-1 State-
ment B” in View/Print mode), will be attached to each Schedule K-1 in returns with 
aggregated businesses.

Aggregated businesses are reported in a single column of the Qualified Business 
Income Information worksheet (“Wks QBI”) with “Yes” entered in the appropriate 
“Aggregated” box at the top-right.

Multiple 
Aggregation 

Groups

It is possible to have more than one distinct aggregation group. To create a second 
aggregation, use another number in the BAN or PBAN fields of the second group. On 
the BAN or PBAN screen, press PAGE DOWN and include a description of the trade or 
business and an explanation of the factors met that allow the aggregation in accor-
dance with Regulations section 1.199A-4. Use the second BAN or PBAN for this 
group.

Figure 13: Entering a PBAN on screen K199
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Aggregated entities are listed in a statement with partners’ Schedules K-1.

Oil and Gas Depletion Worksheet
The DEPL screen is accessible from the Other Forms tab of the Data Entry Menu. 
Create a separate depletion worksheet for each oil or gas interest. (Press PAGE DOWN 
to open a fresh instance of the DEPL screen.) Enter data for cost depletion, percentage 
depletion, or for both. If data for both cost and percentage depletion is entered, the 
program does both computations and sends the one that gives the taxpayer the best 
deduction to the proper form or schedule. (Not all taxpayers have the option of using 
either method. Consult Publication 535 for additional information.)

The deductions from all of the worksheets are totaled and carried to the indicated form 
or schedule.

NOTE
The Depletion Worksheet (“Wks DEPL”) in the Partnership package 
is for informational purposes only. Depletion is calculated in the 
partner’s individual return

Multiple Foreign Transactions
Screen Code: KFT Information on foreign transactions is entered on a separate KFT screen, accessible 

from the Foreign tab of the Data Entry Menu or from line 16 of screen K, Credits 
tab, by clicking the Schedule K Foreign Transactions link. Through the KFT 
screen, you can report multiple foreign transactions. (Press PAGE DOWN for a new 
KFT screen.)

Drake Tax generates a “Foreign Transaction Statement,” shown as “WK_FTRP~” in 
View/Print mode, that lists all of the partnership’s foreign transactions. Separate For-
eign Transaction Statements (“K-1 STM FTR”) are generated for each partner, report-
ing these foreign transactions.

Business Activities Statement
A Business Activities Statement (screen BAS) allows you to break down a partner-
ship’s Schedule K items by business activity. The amounts and totals from the BAS 
screen do not flow anywhere in the partnership return but do provide statements 
(listed in View/Print mode as “Wks BAS”) you can use as a reference when transfer-
ring these amounts into the partner’s 1040 return. A K-1 statement by business activ-
ity is also provided for the partners, listed in View/Print mode as “K-1 Wks BAS.” 
(Figure 14 on page 46).
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At-Risk 
Rules

(New for 2020) At the bottom of the BAS screen are check boxes for line 21, “More 
than one activity for at-risk purposes,” and line22, “More than one activity for passive 
activity purposes.” These check boxes were available on the BAS screen last year but 
did not function.

Mark the box for line 21 if the business activity is covered by the At-Risk rules. 
Selecting this box on screen BAS marks box 21 of Schedule K-1. The required state-
ment attachment will be produced when multiple business activity BAS screens are 
completed (press PAGE DOWN to open a new BAS screen for each activity). Informa-
tion provided in the statement should be used by the partner to figure at-risk limita-
tions for his or her Individual (1040) return.

Passive 
Rules

(New for 2020) Mark the box on line 22 if the business activity is covered by the Pas-
sive Activity rules. Selecting this box marks box 22 of Schedule K-1. The required 
statement attachment will be produced when multiple business activity BAS screens 
are completed (Press PAGE DOWN to open a new BAS screen for each activity). Infor-
mation provided in the statement should be used by the partner to figure passive lim-
itations for his or her Individual (1040) return.

Schedule K-1 for 1065 (Partner Information)
Use the K1 screen to enter data for Schedule K-1, Partner’s Share of Income, Credits, 
Deductions, etc.

Partner’s Name and Address
In the Partner’s Name and Address Information section in the upper portion of the 
K1 screen, enter the SSN/TIN of the partner in the ID number field (line E) and the 
partner’s address (line F). If the partner is an entity rather than individual, enter the 
partner’s name in the Entity name field. (See “Partner Type,” below.)

Figure 14: A Partner’s Business Activities Statement in the 1065 Package
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If the partner signs the return for the partnership, and has a title, you can enter that title 
in the Title for Pin Signature field. That title will appear on the K-1 letters prepared 
for all partners. Override this name with entries on either the PIN screen or COMM 
(also known as the K1L) screen. The COMM screen entries override entries from 
either the PIN screen or the K1 screen. For more on the K-1 letter, see “Editing the K-
1 Letter” on page 57.

Foreign Addresses
If the partner has a foreign address, enter the Province/ State, Country, and Postal 
Code information in the Foreign ONLY address line of the Partner Name and 
Address Information section of screen K1 (along with the street Address and City 
fields in section F). Do not enter anything in the State or ZIP fields. Conversely, for a 
U.S. address, do not enter anything into the foreign address fields.

NOTE
The Foreign ONLY fields are initially locked when a return is opened 
to prevent accidental data entry. Click one of the fields to unlock 
them throughout the return. To again disable the unused Foreign 
ONLY fields, close and then reopen the return.

Partner Type From the line I1 PARTNER type drop list (Figure 15 on page 48), choose the type of 
partner (not the type of partnership). If this box is left blank, the program uses the 
default selection of Individual. On line H1, select Domestic or Foreign partner 
(default is Domestic). If the partner is an Eligible foreign entity, mark the B2 check 
box. (See Figure 15. For more information, see “Eligible Foreign Entity” on page 34.) 
If the partner is a retirement plan (IRS, SEP, Keogh, etc.) mark the I2 check box.

 “Disregarded 
Entity” 

In the case of a Limited Liability Company, from the I1 drop list, select Disregarded, 
for “disregarded entity,” or Individual SMLLC, for “single member LLC,” and on 
line H2, enter the entity’s TIN (if available). Back on lines E and F in the Partner’s 
Name and Address Information section, be sure the ID number, name, and address 
is that of the Schedule K-1 on which this information will be reported is entered – that 
is, the K-1 of the “beneficial owner.”

For instance, if the partner is a SMLLC but the beneficial owner is an individual, enter 
that taxpayer’s SSN on line E and the name of the taxpayer in the line F fields.

NOTE
(optional) For identity protection purposes, you can choose to enter 
only the last four digits of the disregarded entity’s TIN. For line H2, 
type 00000, then the final four digits of the ID number.
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Other Partner Information
Besides the PTR REP check box (see “Partnership Representative” on page 32), the 
Other Information section of the K1 screen offers a place to indicate which partner 
signs the return and which is the rounding partner. The Control number field gives 
you another sorting option. (See “Setting Sort Order of K-1s” on page 49 for more 
information.)

Rounding 
Partner

Mark the Rounding Partner check box 
on screen K1 (Figure 16) to select which 
partner should be the rounding partner 
who will receive any balancing amount on 
Schedule K-1 when the return is calcu-
lated. If you do not make a selection, the 
program designates the first partner you 
entered as the rounding partner.

If you select more than one rounding part-
ner, the program generates a Return Note, 
telling you that you’ve chosen more than 
one rounding partner, along with which 
partner will be used as the rounding partner and which partners will be ignored.

Signs Return If the partner described on this K1 screen is the partner who signs the return for the 
partnership, mark the Signs Return check box (Figure 16). This partner’s information 
will not have to be re-entered on the PIN screen. (The fields ERO PIN, PIN of the 
“sign’s return” partner, and Signature date must still be completed on the PIN screen 
for the return to be eligible for e-file.)

If the partner who signs the return has a title, you can enter that title in the Title for 
Pin Signature field. That title will appear on the K-1 letters prepared for all partners.

Figure 15: Selecting a K-1 Partner Type

Figure 16: Designating a Rounding Partner
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Sorting and Viewing Schedules K-1
View a return with multiple Schedules K-1 
and you will see, in the forms “tree” on the 
left side of the View/Print window (in 
Enhanced View), that each partner has a 
“K1” folder (blue circle in Figure 17) con-
taining Schedules K-1 and any other forms, 
worksheets, statements, and letters generated 
for that partner.

For those who print their K-1 forms from the 
Sets tab in View/Print mode, click the Sets 
tab and notice that each partner has a sepa-
rate folder containing all generated federal 
and state K-1 schedules, forms, and work-
sheets, making it easier to print everything 
needed for the partner (red box in Figure 17).

Click the PLUS SIGN [+] to expand the folder 
to see all documents relating to that partner. 
Click the MINUS SIGN [-] to collapse the folder.

Setting Sort 
Order of 

K-1s

For convenience when dealing with partnerships that have a large number of partners, 
you can sort the list of Schedules K-1 by recipient’s name, ID number, ownership per-
centage, or by the Control number.

The default sort order (as seen in View/Print mode) is determined by the order in 
which the partners are entered in the program. To select a new sort order, go to the 
PRNT screen (available through the General or Miscellaneous tabs of the Data 
Entry Menu) and, from the Sort K1s by drop list, choose:

• Control – Sort by the Control number entered on each screen K1 (See “Control 
Number,” following, for more)

• ID – Sort numerically based on the SSN or EIN of the partner
• Name – Choose to sort by first or last name and individual partners will be listed 

alphabetically by the name you choose. Partners that are businesses, estates, 
trusts, and tax-exempt organizations will be listed by the first letter of the first 
word or name entered in the Entity name line of screen K1.

• Percentage – Sort by the partner’s ownership percentage

Control 
Number

The Control number is an optional number the preparer can use to identify and sort 
Schedules K-1. The number can contain up to five digits, and decimals are allowed. 
Schedules K-1 can be sorted in View/Print mode by selecting Control from the Sort 
K1s by drop list on screen PRNT. The control number is printed at the top of the 
Schedule K-1.

IMPORTANT
Drake Tax does not automatically “increment” the control number. If 
some partners have a control number and others do not, those 

Figure 17: Contents of Partner’s Schedule K-
1 Folder
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without will be listed first in View/Print mode based on the order in 
which they were entered into the program, followed by the partners 
with control numbers, listed numerically.

Grid Data Entry for Screen K1
If you have your program set up to take advantage of grid data entry, you can easily 
enter amounts in many of the most-often used lines of a Schedule K-1. This method is 
particularly useful for partnerships with a lot of partners.

First, initiate grid data entry:

1. Return to the Drake Tax Home window.
2. From the menu bar, select Setup > Options to open the Data Entry tab.
3. Near the bottom of the left-hand column, select Use grid data entry format on 

available screens. Click OK.

Now, open a return, and from the K-1 Information section of the General tab, click 
K1 to open the data-entry grid. To make entries in the grid:

1. Select a partner and click one of the fields where you wish to enter data.
2. Type information for that partner for that column.
3. Scroll across (or press the TAB key) to see more columns and make any entries 

needed.
4. Press the DOWN ARROW to make entries for other partners.
5. To open a partner’s K1 screen and make any other entries, select the line and click 

Item Detail (or press F3).
6. To return to the grid, close the partner’s K1 screen (or press F3).

TIPS
• You can arrange the grid by ID number, by partner’s First or Last 
Name, by Entity name (for partners that aren’t individuals), or by 
the amounts in the columns of the grid by clicking the column 
headers.

• Press F3 to toggle back and forth between grid data entry and 
data entry mode.

• Right-click the grid and choose to export to an Excel or CSV file or 
print the grid. You can also resize the font to make the grid easier to 
read.

Schedule K-1 Codes
New for 2020: The IRS has discontinued page 2 of Schedule K-1 for Form 1065 and 
has instead moved K-1 codes to the Schedule K-1 instructions, but these codes can 
still be generated in Drake Tax.

Instead of producing the entire K-1 code sheet, however, Drake Tax now generates 
only those codes that actually appear on each Schedule K-1. For instance, if the K-1s 
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include codes in boxes 12, 15, and 17, then the only codes produced and explained on 
the K-1 codes sheet will be those for boxes 12, 15, and 17. These codes are printed on 
the “Schedule K-1 Supplemental Information” page that is generated with each K-1, 
and they reference the page in the K-1 instructions where further information can be 
found (Figure 18).

To generate K-1 codes, from the Home window menu bar of Drake Tax, go to Setup 
> Options, click the Form & Schedule Options tab, and mark the Print page 2 of 
Schedule K-1 for 1041 and K-1 codes for 1120S and 1065 box.

For the complete list of Schedule K-1 codes, from the Home window menu bar, go to 
Tools > Blank Forms, click Search, and type 65CODES.

Schedule K-1 may include asterisks with letter codes.

• An asterisk with a letter code indicates that multiple items have that code or that a 
statement is required for the code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and a statement is attached or that a statement 
is required (as in the case of “other” amounts).

Returns with Numerous Partners
For returns with a large number of partners, you have the option of deactivating calcu-
lation and printing of the K-1 schedules while working on Form 1065. This option, 
which eases the process of reconciling the 1065, is available by going to the PRNT 
screen and marking the applicable box under the K-1 Items to Suppress section.

IMPORTANT
After completing K-1 entries for all partners, or once the return is 
reconciled, be sure to reactivate the calculation and printing of the 
K-1s from the PRNT screen.

Figure 18: Schedule K-1 Codes that are used in the return now appear in the 
“Supplemental Information” section of Schedule K-1.
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Partner Overrides
To override calculated amounts for partners, you can either make changes on each K1 
screen or go to one of the SA screens for partner special allocations and make all 
changes there. For more information, see “Special Allocations” on page 37.

Ownership Changes
All ownership change information is entered on the OWN screen, which is available 
from the General tab of the Data Entry Menu. To use the OWN screen:

• At the top of the screen, enter the date the profit, loss, or capital interest in the 
partnership was exchanged by two or more partners. If profit, loss, and capital are 
all involved in a transaction, put the date in the Profit/Loss/Capital field only. 
The Loss and Capital date fields are override fields, provided in case the loss or 
capital dates are different.

• In the Change in Percentages section, select the applicable partner from the drop 
list. (The drop list contains the names and ID numbers of all partners entered on a 
K1 screen.)

• Enter the percentage changes in profit, loss, or capital as positive amounts for 
increases and negative amounts for decreases. 

• To enter additional ownership changes, press PAGE DOWN.

NOTE
See FAQ item “P” in the program for more information on entering 
ownership-change information.

Printed Data A Summary of Change in Ownership worksheet (“Wks POWN”) is generated when 
the return is viewed. The “Wks POWN” worksheet contains a list all partners and the 
ownership percentages and changes.

K-1 Export
Take the following steps to export a Schedule K-1 to another return:

1. Ensure that K-1 data is entered in the exporting 1065 return and that the recipient 
return has been created in Drake Tax. (The K1P screen in the other return does 
not have to be created beforehand.)

2. In the exporting 1065 return, go to View/Print mode.
3. Click K1 Export in the View/Print mode toolbar. A list of SSNs that cannot be 

exported appears, if applicable. (The reason a K-1 is ineligible for export appears 
in the Reason column.) Click Next.

4. The Export K1s dialog box (Figure 19) lists all clients that can be exported. (To 
prevent a Schedule K-1 in this list from being exported, remove the check mark to 
the left of it.)
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5. Click Export. The K-1 data now appears on the partner’s 1040 tax return as a 
K1P screen.

NOTE
Basis information for individual partners should be entered in the 
1040 package in Drake Tax; this information cannot be exported 
from the 1065 package to a 1040 return. Such an import would 
override limitations and carryovers calculated in the 1040 program.

The K-1 Export feature can also export K-1 data from partnership returns into the K-1 
“source” screen (K1P) of the 1065 package.

The Additional Entries tab on screen K1P (Figure 20) offers fields for additional K-
1 information—likewise, should additional information need to be entered after a K1 
screen has been exported, there is an equivalent tab (Add’l entries) on the K1P screen 
in the 1040 package.

Figure 19: Client Schedules K-1 ready to be exported
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Supplemental Information
Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return
• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s), open the K1G screen, 
accessible from the General tab of the Data Entry Menu. Select Global Supplemen-
tal Statement Information from the Select Type drop list, and enter the necessary 
information in the Supplemental Information text box. This information will appear 
in all partners’ Schedule K-1 Supplemental Information statements.

To add supplemental information to an individual K-1 statement, open a partner’s K1 
screen and click the Supplemental Info link at the top of the screen. In the Supple-
mental Information pane (Figure 21 on page 55), enter information pertinent to the 
partner. The information appears in only that partner’s Schedule K-1 Supplemental 
Information statement.

Figure 20: Additional entries tab of the K1P screen
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Item M Question
If the answer to Schedule K-1, item M, Did the partner contribute property with a 
built-in gain or loss, is “Yes” for all partners:

1. On the PRNT screen (accessible via the link PRNT Screen beside item M), select 
Yes in the Item M on Schedule K-1 section.

2. On screen K1G, select K1M - Built In Gain Loss Statement from the drop list, 
and enter any supplemental information needed in the text box below.

If the answer is “Yes” for some partners but not others, use the individual partners’ 
Item M screens to report the supplemental information. The Item M screen is 
accessed by clicking the 8805/Item M tab at the top of any partner’s K1 screen. The 
supplemental information should list each property the partner contributed, the date 
the property was contributed, and the amount of the property’s built-in gain or loss.

Supplemental information entered on either the 8805/Item M tab of screen K1 or by 
using code K1M on screen K1G will appear on the supplemental information state-
ment.

Partner’s Adjusted Basis Worksheet
Use the Partner’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a part-
ner’s new basis after increases or decreases are made to basis during the current year. 
A partner’s adjusted (outside) basis refers to the partner’s investment in a partnership. 
The basis is determined without considering any amount shown in the partnership 
books as capital, equity, or similar account. When a partner disposes of an interest in a 
partnership, the difference between the sale price and the adjusted basis is the taxable 
gain or loss.

The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a partner.

Figure 21: In this example, the information entered on the K1 screen appears on 
only partner Amelia Carter’s Schedule K-1 Supplemental Information statement
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NOTE
The Basis Worksheet (“Wks Adj Basis”) appears in partners’ K-1 fold-
ers only when the check box Print partner’s adjusted basis work-
sheet is selected on the PRNT screen.

Annual 
Update of 

Partner Info.

When the program is updated in 2021, the 2020 end-of-year basis and liability 
amounts become the 2021 beginning-of-year amounts. Any loss or deduction carry-
over is updated to the beginning of the year, and its character (ordinary loss, section 
179 expense, charitable contributions, etc.) is maintained.

NOTE
If Final K-1 is marked on a partner’s K1 screen, none of the related 
screens for that partner will be updated in the 2021 tax program. 

Special 
Allocations

Use the SA screens to allocate liability, capital, and K-1 Part III (Income, Deductions, 
Credits, and Other Items) amounts to individual partners without having to enter the 
information into each K-1 separately. Amounts can be entered as dollar amounts or 
percentages. Calculations from the SA screens flow to the appropriate fields of each 
individual K-1.

For information on the SA screens, see “Special Allocations” on page 37.

Section 754 
Allocations

To allocate section 754 depreciation among specific partners:

1. Open a screen 4562 (accessed from the Assets-Sales-Recapture tab of the Data 
Entry Menu) for each asset for which you plan to allocate section 754 deprecia-
tion. Press PAGE DOWN for additional screens.

2. Select 754 from the For drop list at the top of each screen 4562.
3. Open screen K (from the General tab of the Data Entry Menu), and click the 

Deductions tab.
4. Click the SA link on line 13d, item W, “Section 754 depreciation...” line, and 

enter data as necessary. (See “Special Allocations” on page 37 for details on using 
the SA screen.)

Domestic Production Activities Deduction
The Domestic Production Activities Deduction (DPAD) has been repealed for tax 
years beginning after 2017, with limited exceptions. For those exceptions, the 8903 
screen, used to complete Form 8903, Domestic Production Activities Deduction, is 
still accessible from the Other Forms tab of the Data Entry Menu.

K-1 Cover Letters
K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.
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Producing 
Letters for 

All Returns

To have K-1 cover letters produced automatically with all applicable returns, from the 
Home window menu bar of Drake Tax, go to Setup > Options > Client Communica-
tions tab, and mark the box labeled Include K-1 letter with returns. Click OK, then 
open a return.

NOTE
Also from Setup > Options > Client Communications tab, you 
can choose to have the partnership’s information or your firm’s let-
terhead (and logo) printed at the top of the K-1 letters. 

Screen Codes: 
COMM or K1L

The signature used on the letter flows from the PIN screen. You can override this 
name on the K-1 letters by going to the K1L screen (also the COMM screen, both 
available from the Miscellaneous tab of the Data Entry Menu) and, in the K-1 
Cover Letter section at the bottom of the screen, entering the name and title of the 
person’s signature you wish to use. 

NOTE
The program uses the name of the partner who signs the return 
(selected as the Signs return partner on the K1 screen) as the sig-
natory of the K-1 letter. Override this name with entries on either 
the PIN screen or COMM (also known as the K1L) screen. The 
COMM screen entries override entries from either the PIN screen or 
the K1 screen.

Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your 
office’s needs and style.

NOTE
Review the following sections of the 2020 Drake Tax User’s Manual 
before making changes to letter templates:

• “Introduction to Letters in Drake Tax” in Chapter 2, Installation & 
Setup

• The “Letter Keywords” section of Appendix B, Keywords

To edit the text of the K-1 letter:

1. From the Home window menu bar, select Setup > Communications Editor. The 
Client Communications Editor is displayed.

2. Select Open > Partnership > Partnership K1 Cover Letter to view the tem-
plate of the partnership K-1 letter.

3. Make any desired changes to the template.
4. Click Save.

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended Schedule K-1. To edit the letter for an amended K-1, from 
the Client Communications Editor toolbar, select Open > Partner-
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ship > Partnership K1 Amended Letter, and follow steps 3 and 4 
of the previous procedure.

Other K-1 
Letter 

Options

By default, the partnership’s name and address appear in the letterhead of the K-1 
cover letters, the information flowing from screen 1. (This assumes you first went to 
Setup > Communications Editor > Setup > Page Layout and selected the Use let-
terhead on letters box; otherwise, no header would be printed.)

Printing Firm 
Info. in 

Letterhead

(optional) To have your firm’s contact information and logo printed in the letterhead of 
the K-1 cover letters, go the COMM screen (available from the Miscellaneous tab of 
the Data Entry Menu), and from the Information on the K-1 coversheet... drop list 
at the bottom of the screen, select F - Print firm info/logo.

Preventing 
Printing of 
Letterhead

(optional) To prevent the partnership’s or the firm’s name and address from appearing 
in the header of the K-1 letter, select X - Do not print entity or firm info from the 
Information on the K-1 coversheet... drop list at the bottom of the COMM screen.

Once the required signing information has been selected, a K-1 cover letter will be 
generated for each partner receiving a Schedule K-1.

To change the firm’s letterhead information, from the Home window menu bar, select 
Setup > Communications Editor. Select Open > Partnership > Letterhead (All 
Packages), and make whatever changes you wish. Click Save.

For more on working with letterheads, see “Setting Up Letterheads, Logos, Footers, 
Margins, and Borders” in Chapter 2 of 2020 Drake Tax User’s Manual.

IMPORTANT
Changes made to the letterhead affect the letterhead in all pack-
ages.

Schedule L (Balance Sheets Per Books)
Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2 
to facilitate reconciliation of the balance sheet (item #1 in Figure 22 on page 59).
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Note that the totals from the balance sheet’s subsidiary schedule (SCH2 screen link, 
item #3 in Figure 22) also appear in the BOY Totals and EOY Totals columns of the 
L screen.

If you make any changes to the return’s data, recalculate the return (press CTRL+C) for 
those changes to be displayed on the screen.

TIP
To speed up calculation of returns that contain multiple states, open 
screen 1 and select 0 from the Resident state drop list.

Schedule L is not required if:

• The partnership’s total receipts for the tax year were less than $250,000
• The partnership’s total assets at the end of the tax year were less than $1,000,000
• Schedules K-1 are filed with the return and furnished to the partners on or before 

the due date (including extensions) for the partnership return
• The partnership is not filing and is not required to file Schedule M-3

If the partnership meets all four of these conditions, go to screen B (located on the 
General tab of the Data Entry Menu), and select Yes for line 4. Because Schedules 
L, M-1, M-2, and section L of Schedule K-1 are not required, they will not be gener-
ated with the return. To force the program to generate these items, return to screen L, 
and click the Force-print Schedule L and M-1 link (item #4 in Figure 22 on page 59) 
to open the PRNT screen. In the Items to Print section, select Force Schedules L, 
M-1, M-2, & K-1 Section L.

If any of the four conditions is not met, select No for line 4 on screen B. If No is 
selected, Schedules L, M-1, M-2, and Item L of Schedule K-1 are required and will be 
generated with the return.

Figure 22: Beginning- and End-of-Year totals displayed on L screen (#1); force-printing end-of-year 
totals (#2); link to SCH2 screen (#3); force-printing Schedule L and M-1 (#4)
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Print End of 
Year Totals

If the Final return check box is marked on screen 1, you can select the Force-print 
final end of year check box (see item #2 in Figure 22 on page 59) on screen L to keep 
the program from “zeroing out” the end-of-year totals.

Print 
Section L

You can force the program to generate the K-1 section “L” information without gener-
ating any unnecessary Schedules L, M-2, and M-2.

From the PRNT screen (available from the Miscellaneous tab of the Data Entry 
Menu), select Force Schedule K-1 Section L only, and any available data is gener-
ated in the “L” section, “Partner’s Capital Account Analysis,” of Schedule K-1 
(Figure 23).

Flow of Information
Many entries made elsewhere on the return (for example, inventory information on 
screen A) flow to Schedule L of Form 1065. Depreciable asset information, intangible 
assets, and amortization from the 4562 screen also flow to Schedule L. 

Direct entries on screen L include beginning- and end-of-year Cash, Trade notes and 
accounts received, bad debts, U.S. government securities, Tax-exempt securities, 
Loans to partners, Mortgage/real estate loans, Depletable assets, and Accumu-
lated depletion. Other Schedule L data not entered on screen L comes from the part-
nerships’ income statement, balance sheet, and equity and capital accounts.

The SCH2 Screen
The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
Drake Tax. In other words, if you use this screen for all applicable lines on Schedule 
L, you do not need to make any entries on the L screen.

To access the SCH2 screen from the L screen, click a SCH2 screen link beside line 6, 
8, 13, 17, or 20 (or click inside a field and press CTRL+2).

To create a statement for a line, select the line from the drop list (see Figure 24), and 
enter descriptions and their corresponding amounts. If additional descriptions are 

Figure 23: Section L information on Schedule K-1
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required for the line, or to enter descriptions and amounts for another line, press PAGE 
DOWN to access a new screen.

NOTE
All line selections are carried to next-year’s program when the 
return is updated. Screen descriptions are updated (should line 
numbers have changed), with the 2020 year-end amounts flowing 
to the 2021 beginning-of-year column.

Statements The total amounts entered on the SCH2 screen do not appear on the L screen in the 
program. They are, however, printed on the return where applicable, with references 
to the corresponding statements.

Note that an e-fileable “STATEMENT” is referenced in the return (Figure 24).

SCH2 and 
Trial Balance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If using 
Drake Tax’s trial balance import feature, be aware that SCH2 data cannot be entered 
directly into the trial balance worksheet, as it cannot be imported into the data entry. 
SCH2 detail screens must be created apart from the trial balance worksheet.

When the return is produced, Schedule L reflects the amounts imported from the trial 
 balance worksheets (where direct entry was allowed). For more information, see 
“SCH2 Detail” on page 92.

Figure 24: Data entered as “Other Current Assets” from the drop list on screen SCH2 is 
included as an e-fileable statement and referenced on the applicable line of the return
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Autobalance
Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the capital account on Schedule L by the difference 
between the total assets and the total liabilities and capital/equity before the adjust-
ment.

(Example: If Assets = $1,000 and Liabilities and Capital = $900, the program 
increases the partners’ capital accounts by $100.)

New for 2020: Preparers can now choose to turn off the autobalance feature globally 
(for all returns) at Setup > Options > Calculation & View/Print tab by marking the 
Turn off auto-balance of the balance sheet check box. The option to override the 
global selection on a per-return basis is now toggled via the Reverse autobalance 
setup option check box on screen PRNT.

Schedule M-2 (Analysis of Partners’ Capital Accounts)
Schedule M-2 is used to show what caused changes during the year in the partners’ 
capital accounts. In most cases, the amounts on Schedule M-2 should equal the total 
amounts reported in item L of all the partners’ Schedules K-1.

Amounts entered for item L in the Partner’s Capital Account Analysis section on 
the partners’ K1 screen of Drake Tax flow to Form 1065, Schedule M-2, line 1, “Bal-
ance at beginning of year.”

Schedules M-1, M-3 (Reconciliation of Income)
Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total 
assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages 
1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

Schedule M-1
Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with the taxable income.

Use the M1 screen (found on the General tab of the Data Entry Menu) to enter 
book-to-tax difference for Schedule M-1. Book-to-tax differences are classified as 
permanent or temporary, and as favorable or unfavorable, as described in Table 2:

Table 2: Examples of Book-to-Tax Difference for Schedule M-1 

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest
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 “Other” 
Adjustments

Open the Schedule M1 Other Adjustments screen to make adjustments to Section L, 
“Partner’s capital account analysis,” of the partners’ Schedules K-1. To open the 
Schedule M1 Other Adjustments screen, click a blue Other link (circled in 
Figure 25) on lines 2, 4, 6 or 7 of screen M1.

On the Other screen, enter a Description and an Amount, and close the screen. When 
you calculate the return, the amounts entered on the Other screens have adjusted Sec-
tion L of the Schedules K-1.

NOTE
If you enter an amount in the line 2, 4, 6, or 7 override fields on 
screen M1 and enter that amount again on the Other screen, the 
amounts will be added and the total will flow to Schedule M-1. 
(Only the amount entered on the Other screen affects Section L of 
Schedule K-1, however.)

To allocate these adjusted amounts to the partners, click the SA link 
on the right side of the Amount field on the Other screen. For more 

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation
- Gains or losses on the sale of 
depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment

Table 2: Examples of Book-to-Tax Difference for Schedule M-1 (continued)

Difference Description Examples

Figure 25: Other screen links from screen M1
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on using the Special Allocation (SA) screens, see “Special Alloca-
tions” on page 37.

Depreciation 
and 

Amortization 
Adjustments

The program can make an adjustment for book-to-tax depreciation differences. The 
calculation is done with the following steps. (This procedure refers to “depreciation” 
throughout, but it applies for either depreciation or amortization.)

1. The amount reported on Schedule L (screen L) on the “Beginning of Year” Accu-
mulated depreciation line (line 9b, column a) (line 10b is “Accumulated deple-
tion”), is subtracted from the “End of Year” Accumulated depreciation line (line 
9b, column c). This is the “book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is the depreciation amount reported on the return, 
including any section 179 amounts).

3. The differences between the “book” and “tax” depreciation amounts are carried to 
the appropriate form and line.
• If the “book” depreciation amount is greater than the “tax” depreciation 

amount, the difference is carried to one of the following:

– Schedule M-1, line 4a, “Depreciation $”
– Schedule M-3, Part III, line 25, “Depreciation” (as a negative amount)
– Form 8916-A, line 2(L), “Depreciation,” as a negative amount for assets 

selected on the 4562 detail screen for COGS
• If the “tax” depreciation amount is greater than the “book” depreciation 

amount, the difference is carried to one of the following:

– Schedule M-1, line 7a, “Depreciation $”
– Schedule M-3, Part III, line 25, “Depreciation” (as a positive amount)
– Form 8916-A, line 2(L), “Depreciation,” as a positive amount for assets 

selected on the 4562 detail screen for COGS

Schedule M-3
The Schedule M-3 section on the General 
tab of the Data Entry Menu includes 
direct access to the various M3 screens 
(Figure 26).

If a domestic partnership reports on Form 
1065, Schedule L, that its total assets at the 
end of its tax year equal or exceed $10 mil-
lion (or that its gross receipts equal or 
exceed $250,000), it must complete and 
file Schedule M-3 instead of Schedule M-1.

NOTES
• The program calculates total assets based on IRS requirements. 
For more information, see the Adjusted Total Assets Worksheet 

Figure 26: Schedule M-3 screens
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(“Wks M-3”) produced with the return and available in View/Print 
mode.

• Some calculated amounts flow automatically to Schedule M-3; 
other data must be manually entered on the M3 screen. Be sure to 
review all amounts on the Schedule M-3.

Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the 
tax return (per Schedule M-3, Part I, line 11) to net income (loss) on Form 1065, page 
5, “Analysis of Net Income (Loss),” line 1.

If the partnership is required to file (or voluntarily files) Schedule M-3, the partnership 
must file Form 1065 and all attachments and schedules, including Schedule M-3. 
Additional information could be required on the 8916 and SCH3 screens.

Force-Printing Schedule M-3
Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the 
year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the 
total assets equal or exceed $50 million. If the corporation’s assets do not equal or 
exceed $10 million but you want to voluntarily file Schedule M-3, or if the corpora-
tion’s assets do not equal or exceed $50 million and you wish to file the complete  
M-3, go to screen M3 and make a selection from the Force print schedule M-3 drop 
list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

See “Schedules M-1, M-3 (Reconciliation of Income)” on page 62 for more details on 
these schedules.

SCH3 
Screen

The SCH3 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule M-3 (or Form 8916-A). This screen can be used in place of the 
actual M3 screen in Drake Tax. In other words, if you use this screen for all applicable 
lines on Schedule M-3 or Form 8916-A, you do not need to make any entries on the 
M3 and 8916 screens. The total amounts entered on the SCH3 screen do not show up 
on the actual M3 and 8916 screens in the program; those amounts are printed, how-
ever, on the return, as applicable, with references to the corresponding statements.

To create a statement for a line, select the desired line from the Select line number 
from drop list on screen SCH3, then enter descriptions and their corresponding 
amounts. If additional descriptions and amounts are required for the line, or to enter 
descriptions and amounts for another line, press PAGE DOWN to access a new screen. 
If entering additional data for the same line on a new SCH3 screen, be sure to make 
the same selection from the Select line number... drop list.

NOTE
All line selections flow to the next-year program when the return is 
updated to the next tax year.

As with the SCH2 screen, the type of statement produced by the program depends on 
the line selected on the SCH3 screen and the IRS requirements. See “The SCH2 
Screen” on page 60 for more information on how to use the SCH3 screen.
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Allocating 
M-3 Items

The SA links on screens M32 and M33 (Parts II and III) for Schedule M-3 allow you 
to allocate to the partners any Temporary Differences and Permanent Differences for 
income items (screen M32) and expense items (screen M33).

See “Special Allocations” on page 37 for details on using the SA links.

Rental Activities
Screen code: 8825 Income and expenses for rental real estate properties appear on Form 8825, Rental 

Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake Tax, use the 8825 screen, available from the Other Forms tab of the 
Data Entry Menu. (Grid data entry is available for this screen. See “Grid Data Entry 
for Screen K1” on page 50 for details on using this feature.)

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 
reports each property’s information on a separate column of Form 8825. Data from all 
8825 screens are transmitted to the IRS when the return is e-filed.

NOTE
Special steps are required if using the trial balance worksheet for 
multiple rentals. See “Rental Expenses” on page 93 for more infor-
mation.

Line 14, Depreciation
If the program is calculating depreciation (entered on the 4562 screen) for the prop-
erty listed on the 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake Tax program, and then the 
net results should be entered on screen 8825. Line 14, “Depreciation,” of the 8825 
screen is an adjustment field: any amount entered on line 14 is added to the deprecia-
tion calculated from the 4562 screens.

NOTES
• For assets placed in service during the year, Form 4562 is 
required.

• Drake Tax produces one Form 4562 for each property on Sched-
ule E and Form 8825 instead of one 4562 per Schedule E or 8825.

Information 
Flowing to 
Form 8825

To indicate that the information should flow to Form 8825, select 8825 from the For 
drop list on screen 4562 (Figure 27). If there are multiple 8825 screens, use the Multi-
form code box. For information on using the Multi-form code box, see the 2020 
Drake Tax User’s Manual.
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Any depreciation information entered on the 4562 screen flows to the correct Form 
8825, based on the form and multi-form code selections at the top of the 4562 detail 
screens.

IMPORTANT
When selecting a multi-form code, note that the code should refer 
to an 8825 screen—not the 8825 form. For example, data from the 
third 8825 screen is generated on the first Form 8825. To associate 
an asset with that information, you would type a “3” for the screen 
(not a “1” for the form) in the Multi-form code box. For more infor-
mation on Form 8825, see “Viewing Rental Activity Information” on 
page 68.

Information 
Flowing from 

Form 4797 

If the corporation sold rental property, and screen 4797 is completed, data flows from 
Part II, line 17, “Combine lines 10 through 16,” of Form 4797, to the first Form 8825, 
line 19, “Net gain (loss) from Form 4797, Part II, line 17, from the disposition of prop-
erty from rental real estate activities.”

Line 15, Other Expenses 
For rental properties with an “other” expense (line 15 of Form 8825), enter the amount 
of guaranteed payments, health insurance payments, and meals in the appropriate 
fields of the 8825 screen (Figure 28). For rental properties with expenses not listed, 
enter those amounts in the Additional other expenses field. (An entry in this field 
opens a Detail Worksheet. Enter a description in the Description field and an amount 
in the Amount field.) The shaded field indicates a worksheet was entered.

Totals from the worksheet flow to Form 8825. A statement from each property is gen-
erated with the return and transmitted to the IRS when the return in transmitted.

Enter rental income the partnership receives on a Schedule K-1 on the K1P screen. 
This amount flows to Form 8825, lines 20a and 20b. No entry is required on the 8825.

Figure 27: In this example, the program sends the 4562 information
to the third 8825 screen created.

Figure 28: Fields for entering line 15 “other” data on screen 8825
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NOTE
Entries in the “Guaranteed payments” fields and “Health insurance 
payments” field on screen 8825 do not flow to line 10, “Guaranteed 
payments to partners,” of Form 1065 but do flow to Form 8825 and 
do adjust the amounts on lines 2, “Net rental real estate income 
(loss),” and 4, “Guaranteed payments,” of Schedule K.

Qualified Business Income on Screen 8825
If this rental activity is a trade or a business, select Yes from the This activity is a 
trade or business drop list in the Qualified Business Income (QBI) section of the 
8825 screen. For a possible aggregation of business for the partners’ individual 
returns, type an appropriate number in the Potential Business Aggregation Number 
(PBAN) field. For more information on using these fields, see “Passing Through QBI 
Information” on page 39 and “Aggregation, BAN, and PBAN” on page 42.

NOTE
The This activity is a trade or business drop list is a required field 
and must be answered for each 8825 activity.

Viewing Rental Activity Information
Rental activity data is reported on the 8825 forms and accompanying statements.

• 8825 Forms — Form 8825 can 
contain information for up to 
eight rental activities. If more 
than four rental activities are 
entered, a second page of Form 
8825 is generated. If more than 
eight rental activities are 
entered, a second Form 8825 is 
created (Figure 29).

• 8825 Statements — Statements 
are titled “Statement 8x,” (or 
“STM 8X, depending on your 
Setup options) where “X” equals 
“A” to “H” for the first Form 
8825. (For example, the state-
ments for the first and second 8825 screens would be labeled “Statement 8A” and 
“Statement 8B,” respectively.) (See Figure 30 on page 69.)

Figure 29: If there are more than eight rental 
activities, a second Form 8825 is created
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Self-Employment Income
If Mark this box to include in self-employment income is selected at the top of the 
8825 screen, the amounts from the 8825 screen are included in the calculation for line 
14a, “Net earnings (loss) from self-employment,” of Schedule K and flow to each  
K-1. Self-employment calculations are shown on line 1b, “Net income (loss),” on the 
Figuring Net Earnings (Loss) From Self-Employment worksheet (“Wks SE”).

Royalties Worksheet
When income and expenses from royalties are entered on screen 8825 (and Royalties 
is selected from the Type of property drop list), Drake Tax generates the Royalty 
Worksheet (“Wks PROY” in View/Print mode), along with a K-1 Royalty Worksheet 
(“Wks K-1 PROY”) for each partner. 

When a 1065 return is viewed, instead of the royalties’ income and expenses flowing 
to box 2, “Net rental real estate income,” of Schedule K-1, gross royalties flow to 
Schedule K, line 7, “Royalties,” and expenses to Schedule K, line 13d, “Other deduc-
tions.” These amounts are also on the Royalty Worksheet.

NOTE
Form 8825 will not be generated unless otherwise needed. 

Form 8997, Initial and Annual Statement of QOF Investments 
An investor in a qualified opportunity fund (QOF) uses Form 8997 to inform the IRS 
of the QOF investments and deferred gains held at the beginning and end of the cur-
rent tax year, as well as any capital gains deferred and invested in a QOF in the current 
year, and QOF investments disposed of during the current tax year. When an investor 
acquires or sells the investment, it must also be reported on Form 8949, Sales and 
Other Dispositions of Capital Assets.

Figure 30: Form 8825 statements and attachments
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Screen 8997 is located on the Other Forms tab of the Data Entry Menu.

Reporting 
QOF 

Investments

From the Part drop list on screen 8997, select which part of the form you are complet-
ing:

• Part I — Used to declare the partnership’s QOF investments held at the beginning 
of the current tax year.

• Part II — Used to report the partnership’s capital gains for the current tax year that 
were deferred by investing in a QOF.

• Part III — Used to report the partnership’s QOF investments disposed of during 
the current tax year.

• Part IV — Used to report the partnership’s QOF investments held at the end of the 
current tax year due to current-year capital gain deferrals and prior tax years’ 
deferrals.

For each investment, enter the EIN of the QOF, along with the date that the QOF 
investment was acquired, a description of the interest acquired, and the amount that 
was short-term deferred gain and long-term deferred gain.

Mark the check boxes at the bottom of the screen as appropriate.

Press PAGE DOWN to create an additional 8997 screen, and make another selection 
from the Part drop list.

QOF Investments 
There are special rules for eligible gains invested in Qualified Opportunity Funds.

Form 8996 A partnership files Form 8996, Qualified Opportunity Fund, annually to report that the 
QOF meets the 90 percent investment standard of section 1400Z-2 or to figure the 
penalty if it fails to meet the investment standard.

In Drake Tax, use screen 8996 to complete Form 8996. Screen 8996 is available from 
the Other Forms tab of the Data Entry Menu.

Part 1 certifies that the partnership was organized to operate as a QOF. Part II deter-
mines whether the partnership meets the 90 percent investment standard for a QOF. 
Entries in Part IV calculate any penalties for each month that the QOF did not hold at 
least 90 percent of its assets in Qualified Opportunity Zone (QOZ) property.

Complete Parts 1, II, and IV on screen 8996. Click the link at the bottom of the screen 
to complete Parts V and VI.

QOZ Tract 
Numbers

On the Parts V and VI screen, select the form Part to which data entered in a speci-
fied row should flow. In the QOZ Tract No. column, enter the designated 11-digit 
census tract number. (To find this tract number, go to irs.gov/pub/irs-drop/n-18-48.pdf 
for a list of Designated Qualified Opportunity Zones, listed by state and county.)

See Form 8996 and its related instructions for more information.
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Credits and Adjustments
Certain credits require an adjustment to either income or expenses. Drake Tax carries 
the required adjustments to the appropriate line of the return and to Schedule M-1.

NOTE
No adjustment is carried to Schedule M-3 automatically. 

Manually reducing the expenses/deductions or increasing the income for these credits 
causes the return to be out of balance.

Employer Credit for Paid Family Medical Leave
Screen Code: 
8994

The Family Medical Act credit is available in all Drake Tax packages, using Form 
8994, Employer Credit for Paid Family and Medical Leave. Click the 8994 link on the 
Credits tab of the Data Entry Menu to open screen 8994.

Elections
The ability to make certain tax elections is included in the Partnership package. Elec-
tions are made and described on the ELEC screen (Figure 31 on page 72).

Making an Election in Drake Tax
Screen code: 
ELEC

To indicate that the partnership is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu).

2. Make a selection from the Election drop list.
3. Complete all other fields as applicable. Press F1 in any field to learn if that field is 

required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field (Figure 31 on page 72) 
shows that the field is required only for election options 08, 11, 13, 15, and 21, 
and it explains what, specifically, should be entered for each of these elections.
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To open a new ELEC screen for an additional election, press PAGE DOWN.

NOTE
If the election option you selected is not listed in the help text for a 
field, then that field should be left blank. For example, if you chose 
election 01 (General Election Statement), you would not need to 
enter anything into the Date or year-ending field (help text in 
Figure 31).

Election Statements
Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “Statement ELXX,” where “XX” is the number of the 
election. For example, election 01 (General Election Statement) is generated as “State-
ment EL01.”

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date, amount, or location.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Safe Harbor Elections
Marking the Building qualifies for Section 1.263... check box on screen 4562 applies 
a small taxpayer Safe Harbor election to a building listed in the Description field. An 
election statement is produced, and the building description as entered in the Descrip-
tion field is included in the election statement (see Figure 32 on page 73).

Figure 31: Help text for Date or year-ending field on screen ELEC
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NOTE
This (Sec. 1.263(a)-3(h)) Safe Harbor election covers buildings only. 

This Sec. 1.263(a)-3(h) Election can also be made from the ELEC screen (election 
44), as can a Sec. 1.263(a)-1(f) de minimis safe harbor election (43) and a Sec. 
1.263(a)-3(n) election (45).

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

Election statements from screens 4562 and ELEC are generated with the return 
(Figure 32).

Making Changes on the Fly
Screen code: 
PRNT

Use the PRNT screen (accessed from with the General or the Miscellaneous tabs of 
the Data Entry Menu) to override program defaults.

Suppressing/Forcing Documents
To suppress or force the printing of certain documents, go to the PRNT screen, and 
select the desired options. Many “on the fly” changes override global settings from 
Setup > Options. 

1065 Items The following Form 1065 items can be “forced” (forced to be generated or printed) or 
suppressed from the PRNT screen:

• Force Schedules L, M-1, M-2, & K-1 Section L — Schedules L, M-1, M-2, and 
K-1 Section “L” are not printed unless required. To have these schedules printed 
with the return, select this box.

Figure 32: Election statements, including the Safe Harbor election
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• Force Schedule K-1 Section L only — “Force” the program to generate the K-1 
section “L” information without generating any unnecessary Schedules L, M-1, 
and M-2. Any available data is generated in section L, “Partner’s capital account 
analysis,” of Schedule K-1.

• Print Form 4562 — Form 4562, Depreciation and Amortization, is not generated 
unless applicable. Select this box to force the Form 4562 to be printed. (To force 
Form 4562 for all returns, go to Setup > Options > Form & Schedule Options 
tab, and clear the check box labeled Print Form 4562 only when required.)

• Print next-year depreciation listing— Select this box to print the next year’s 
depreciation schedule. (To force this for all returns, go to Setup > Options > 
Form & Schedule Options tab, and mark the box Next-year depreciation 
schedule.)

• Print inactive return — By default, the program does not generate a return for a 
partnership that is inactive. Select this option to override the default for an inac-
tive return.

• PIN — To have the preparer’s signature appear on the printed copy of return, 
enter the preparer’s PIN here. This should be used for the client’s and preparer’s 
printed copies when the return has been e-filed.

• Items to Suppress — Select the boxes corresponding to any worksheets, forms, 
or functions you do not want printed with the return:
– “Wks Tax/Lic” or the “Wks Sal/Wage” reference on page 1
– Estimated Tax Payment Summary
– Printing of “Wks M-2,” Partners’ Capital Reconciliation Worksheet
– Proformas for next tax season
– Special Allocation Statement — Select to keep the statement listing all special 

allocations from being generated.

K-1 Items Described below are Schedule K-1 items that can be forced or suppressed from the 
PRNT screen:

• Select to Print:
– The partner’s adjusted basis worksheet
– Schedule K-1 codes

• Select to Suppress:
– Schedule K-1, K-1 letter, K1_ATT, or WK_PBAS
– Schedule K/K-1 Comparison Worksheet or the Capital Account Reconcilia-

tion
– K1_179 for each partner
– Marking of “Amended K-1” box on printed Schedule K-1

• State Use Only - Partner’s capital account analysis — New for 2020: The IRS 
now requires that all federal partnership returns use the tax basis for reporting 
partners’ capital and, as such, Drake Tax automatically uses the tax basis method 
by default for item L on Schedule K-1; however, many states continue to use alter-
native methods. If reporting partner capital for a state return and the state does not 
use the tax basis method, either select or enter the applicable basis for the state 
(see item #1 of Figure 33 on page 75).
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• Item M on Schedule K-1 — Select a box (item #2 in Figure 33) to answer item 
M of Schedule K-1 for all partners. To answer it for each individual partner, go to 
the partners’ K1 screens. See “Item M Question” on page 55 for more informa-
tion.

• Item L. Partner’s Capital Analysis - Beginning capital account — New for 
2020: With the IRS requiring all federal 1065 returns to use the tax basis method 
beginning in tax year 2020, Drake Tax has added an additional section to screen 
PRNT to automatically convert returns previously using alternative methods to 
the tax basis. If the method used in prior-years to calculate partners’ capital on 
section L of Schedule K-1 was not the tax basis, either select or enter the previous 
method on this section (Figure 34). The beginning capital method will be printed 
across the top of section L, and the converted basis will be calculated on the 
Beginning capital account line of the partner’s Schedule K-1.

Overriding Other Setup Options
Select Reverse autobalance setup option to override the setting made from Setup > 
Options > Calculation & View/Print tab, either activating or disabling autobalance, 
depending on your selection (see “Autobalance” on page 62). Select Prepare a Form 
7004 extension if sending an extension application. (See “Filing an Extension” on 
page 27.)

The following program default settings also can be overridden from the PRNT screen:

• Schedule K-1 sort order

Figure 33: Ttem 1: Electing an alternative basis for an applicable state 
partnership return; item 2: answering item M on Schedule K-1 globally

Figure 34: Entering prior partner capital calculation method to convert to 
the tax basis method
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• Date to print on return
• Amount on Form 1065, page 1, item F (“Total assets”)
• IRS Service Center

Instructions/ 
Coversheets

Filing instructions (federal and state) and envelope coversheets (partnership, IRS, 
state, city, and K-1s to partners) can be edited on the COMM screen. Access the 
COMM screen by click the Filing instruction and coversheet options link on screen 
PRNT, and use the COMM screen to override global selections in Setup > Options.

For more on global options and the COMM screen, see Chapter 2 of the 2020 Drake 
Tax User’s Manual.

Required Security Information
The purpose of Drake Tax’s Filing Security Information screen (SEC) is part of an 
IRS initiative to protect businesses and tax return preparers from data theft and tax 
fraud. Information entered on the SEC screen is transmitted when the tax return is e-
filed.

New for 2020: The partnership’s 2019 income is now required. If the partnership’s 
return was filed through Drake Tax last year, the Total prior year income amount 
will be imported automatically when you update the 2019 return to the 2020 package. 
(That amount also will flow to the “2019” column of the COMP screen in the 2020 
package.) If the partnership’s return was not filed through Drake Tax—or if you wish 
to change the amount imported from 2019—enter the amount in the Total prior year 
income amount field on the SEC screen.

Completing the rest of the SEC screen is optional for 2020; however, certain states 
will begin requiring this information in the near future.

Screen SEC is accessible via the Filing Security Information link at the bottom of 
screen 1 or from the General tab of the Data Entry Menu.

Electronic Filing
Some partnerships with more than 100 partners are required to e-file Form 1065, 
Schedules K-1, and other related forms and schedules. For other partnerships, e-file is 
optional.

IMPORTANT
The IRS does not allow the following types of partnership returns to 
be e-filed:

• Bankruptcy returns

• Returns with pre-computed penalty and interest

Additional Return Types
The following special types of business returns can be e-filed using Drake Tax:
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• Form 5471, Information Return of U.S. Persons With Respect To Certain Foreign 
Corporations

• FinCEN Form 114, Report of Foreign Bank and Financial Accounts
• Returns for entities using a 52-53–week year
• Short-year returns
• Inactive returns

For information on how to indicate a short-year return in Drake Tax, see “Short-Year 
Returns” on page 14.

Form 5471
Screens used to complete Form 5471, Information Return of U.S. Persons With 
Respect To Certain Foreign Corporations, are found in the Information Return For-
eign Corporations section on the Foreign tab of the Data Entry Menu. Form 5471 
is used by certain U.S. citizens and residents who are officers, directors, shareholders, 
or partners in certain foreign corporations. Taxpayers who must file this form are 
described in the IRS instructions.

Schedule I-1
Section 951A requires U.S. shareholders of controlled foreign corporations to deter-
mine and include their Global Intangible Low-Taxed Income (GILTI) in taxable 
income every year. Section 951A is effective for tax years of foreign corporations 
beginning after 2017 and tax years of U.S. shareholders in which or with which such 
tax years of foreign corporations end. This information is reported on Schedule I-1 of 
Form 5471.

In Drake Tax, use the I1 screen, available on the Foreign tab of the Data Entry 
Menu, to provide the necessary information.

For details on using this form, see the IRS instructions for Form 5471 or review the 
field helps on screen I1.

Specified Foreign Corporations and Form 965
Section 965 of the Code (section 965) was amended by section 14103 of the Tax Cuts 
and Jobs Act (TCJA), requiring certain taxpayers to include in income an amount 
based on the accumulated post-1986 deferred foreign income of certain foreign corpo-
rations of which they are U.S. shareholders, either directly or indirectly, through other 
entities. This is reported on Form 965, Inclusion of Deferred Foreign Income Upon 
Transition to Participation Exemption System.

In Drake Tax, the SFC screen and 965 screens are used to complete Form 965. These 
screens are located in the Form 965 and Schedules section on the Foreign tab of the 
Data Entry Menu.
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Foreign Forms
Use screens on the Foreign tab of the Data Entry Menu for entering data on foreign 
financial accounts, for filing FinCEN Form 114, Report of Foreign Bank and Finan-
cial Accounts, Form 8804, Annual Return for Partnership Withholding Tax, Form 
8805, Foreign Partner’s Information Statement of Section 1446 Withholding Tax, and 
Form 8813, Partnership Withholding Tax Payment Voucher.

Forms 8804 
& 8805

Use screen 8804 for reporting total section 1446 liability and additional Form 8804 
information.

To allocate to a foreign partner the tax calculated on Form 8804, open the applicable 
partner’s K1 screen and select the 8805 / Item M tab. On line 9, enter the percentage 
you wish to allocate. The percentage determines the withholding tax allocated and tax 
credit available to the foreign partner (Form 8805).

In order for Form 8805 to be generated, a completed Form 8804 must also be present 
in the return. On the foreign partner’s K1 screen, make sure Foreign Partner is 
selected on line H1. From the 8805 / Item M tab, complete all applicable information. 
The following four copies will be generated for each applicable partner:

• Copy A (IRS): Attach to Form 8804, and paper-file
• Copy B (Partner): Keep for your records
• Copy C (Partner): Transmit with (or attach to) Form 1065
• Copy D (Withholding Agent)

Form 8813 Screen 8813, used for completing Form 8813, allows you to enter amounts paid by the 
partnership in the prior year on foreign tax withheld and to produce vouchers for mak-
ing 2021 quarterly payments. The filing and mailing instructions are listed on screen 
8813.

FinCEN 
Form 114

When you calculate a return in Drake Tax, any required information missing from 
screens 114 and FRGN generates EF Messages unique to the FinCEN Form 114—
listed in “FBAR Messages Page” in View/Print mode below “MESSAGES.” Before 
the FinCEN Form 114 can be eligible for e-file, all FinCEN 114 EF Messages on the 
“FBAR Messages Page” must be cleared; “FinCEN” must also have a green check 
mark on the Calculation Results window. (To see this window, make a valid selection 
from the Pause option for calculation drop list, selected at Setup > Options > Cal-
culation & View/Print tab.)

Next, in data entry, open screen EF, mark the FinCEN 114 only check box. Return to 
screen 114 and select FinCEN Form 114 is ready for transmission at the top of the 
screen—the form cannot be e-filed unless this box is marked. When ready, view the 
return. “FinCEN114” will be indicated in EF Status pane on the Calculation Results 
window, and “Form 114” is both displayed in the forms “tree” and listed on the bill.

Close the return, and from the Home window toolbar, go to EF > Select Returns for 
EF. “FinCEN 114” will be displayed in the EF Documents column of the EF Return 
Selector.

Proceed as you would to e-file any other return in Drake Tax.



Drake Software User’s Manual - Partnerships (1065)

Tax Year 2020                                                                                               79 

NOTES
• Drake Tax produces “EF Notice - FBAR” as an acknowledgment 
that the e-filed FinCEN Form 114 report was received.

• No other returns—state or federal—can be transmitted with the 
FinCEN Form 114 through Drake Tax.

• The link to the BSA website is available on screen 114 (BSA E-Fil-
ing System) for those who prefer that method of filing or who are 
seeking more information.

• For further information, refer to FAQ item W, Foreign Accounts 
and FinCEN 114.

Electing a 52-53–Week Year (Initial Return)
To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the YEAR screen.

To elect a 52-53–week year for any entity:

1. In the If Not Calendar Year section of screen 1, enter the Fiscal year beginning 
and Fiscal year ending dates. Use the MMDDYYYY format, as shown in the 
example below (Figure 35).

2. Mark the 52-53-week tax year box. 

In this example, the fiscal year begins 09/29/2020 and ends 09/27/2021 (the last Fri-
day in September), giving the entity a 53-week year for 2021.

NOTE
An entity that has filed returns in the past must complete only steps 
1 and 2 of this process. An entity that has never filed a return before 
must continue with steps 3 through 6.

3. Click the Year link to open the Short Year Elections screen.
4. For line 1, select the month in which the 52-53–week year ends for the current fis-

cal year. (01 = January, 02 = February, etc.)
5. For line 2, select the day of the week the tax year always ends.

Figure 35: Electing a 52-53–week tax year
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6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ending field on screen 1). 

IMPORTANT
Once a 52-53–week year is selected, the entity must use that 
accounting period every year. To change accounting periods, the 
entity must submit to the IRS Form 3115, Application for Change in 
Accounting Method. Screens for completing Form 3115 are avail-
able from the Other Forms tab of the Data Entry Menu.

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program will update the dates automatically upon updating the return to 
the next year.

Inactive Returns
Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake Tax. To indicate that a return is inactive:

Screen Code: 
PRNT

1. Go to the PRNT screen, accessible from the General tab or the Miscellaneous 
tab of the Data Entry Menu.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, to the right of lines 1a and 1b). Zeros (“0”) 
are displayed where required by the IRS in order for amounts to be properly included 
in the e-file data.

Common Reject Codes
If one or more of the following IRS reject codes are generated when you e-file a 1065 
return, you must contact the IRS for further information. The e-file help desk number 
is (866) 255-0654.

• Reject Code R0000-900-01 — The return type indicated in the return header 
must match the return type established with the IRS for the EIN.

• Reject Code R0000-922-01 — Filer’s EIN and Name Control in the return header 
must match data in the e-File Database, unless “Name Change” or “Name of 
address change” check box is checked, if applicable.

Figure 36: Entering 52-53–week year details on screen YEAR
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Record Keeping
The MISC screen, accessible from the Miscellaneous tab of the Data Entry Menu, 
includes fields to help preparers keep up with the production schedule of a return: 
Date promised, Date picked up, how much the client was charged last year (the 2019 
prep fee field), and a check box for indicating clients who did not pay their bill last 
year. This is preparer information only and has no affect on the return.

The Disaster Designation field on the MISC screen is for entering the name of a fed-
erally designated disaster for those business entities that incurred disaster losses and 
that are subject to federal disaster rules. An entry in this field is printed across the top 
of the return but does not otherwise affect the return The field is limited to 75 charac-
ters (including spaces).

PDF Attachments
PDF files can be attached to certain tax forms. These attachments are generally signa-
ture or third-party documents such as a copy of a signed lease or a signed appraisal 
statement. In some instances, the IRS requires that a document be attached to an e-
filed return; in other instances, a document can be attached voluntarily to support or 
explain an entry in the return.

The PDF Attachment Process
Three main steps are involved in the PDF attachment process in Drake Tax:

1. Creating a PDF document to be attached
2. Informing the program that a PDF document will be sent with the return
3. Attaching the PDF document for e-file

These steps are described in the following sections.

Creating a 
PDF File

If the document which needs to be attached is already a PDF, skip to “Adding PDFs to 
Drake Documents” on page 82. Otherwise, proceed to the proper section (either 
“Paper Document to PDF” or “Electronic Document to PDF”), and follow the indi-
cated steps.

Paper 
Document to 

PDF

To convert a third-party document to PDF (such as a signature form, appraisals, or 
articles of incorporation) to a PDF:

1. Open the return in Drake Tax.
2. From the Data Entry Menu toolbar, click Documents to open Drake Documents.
3. From the Drake Documents toolbar, click Scan.
4. Enter a name for the document or select a name from the drop list. Make sure 

.PDF is the selected format. Use 50 or fewer characters, and do not use single 
quotes (‘’), double quotes (“”), angle brackets (< >), ampersands (&), or exclama-
tion points (!).

5. Click Scan. Drake Documents copies and saves the client’s document into the cli-
ent’s folder of Drake Documents.
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From here, proceed to “Adding PDFs to Drake Tax.”

Electronic 
Document to 

PDF

To convert an electronic document to a PDF:

1. Open the document in the program in which it was created. (For example, open a 
spreadsheet in Excel.)

2. Go to Save As, and when prompted to save the file, change the extension to .PDF 
(either manually or from a Save Type drop list). Save the document to a location 
where you can easily find it.

3. Rename the document to something that clearly identifies the content (or, if appli-
cable, enter a required title). Use 50 or fewer characters, and do not use single 
quotes (‘’), double quotes (“”), angle brackets (< >), ampersands (&), or exclama-
tion points (!).

Adding PDFs 
to Drake 

Documents

PDFs must be uploaded to Drake Documents before they can be attached through 
Drake Tax and e-filed with the return. To upload a PDF to Drake Documents:

1. In Drake Tax, open the return, and click Documents from the Data Entry Menu 
toolbar. Drake Documents is opened.

2. Select the folder in the Working Cabinet where the document will be stored.
3. From the toolbar, click Import to open the Import File dialog box.
4. Browse to an select the desired document. Click Open. Drake Documents copies 

the PDF into the selected folder. 

The document now exists as a PDF in Drake Documents and can be attached to the 
return.

Adding PDFs 
to Drake Tax

Once you have all necessary attachments saved as PDF documents, open the return in 
Drake Tax, and complete the PDF screen, accessible from the General tab of the Data 
Entry Menu.

For each document, fill out the columns on the PDF Attachments screen (see 
Table 3).

Table 3: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source
(This field is for your 
records only; it is not 
transmitted with the 
PDF.)

Regulation, publication, or form 
instructions that instructed you to 
provide the attachment

- IRS Pub xxx-1.4
- Form Instructions for 1065

Description Description of the attachment, 
using up to 28 characters.

- Title of house on Oak Street
- Appraisal of Lot 1234

File name File name of the saved PDF. The 
file name must end with “.PDF”

- TitleHouseOakSt.PDF
- AppraisalLot1234.PDF
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Attaching 
Documents 

to the Return 

To attach a PDF to a return:

1. When data entry is complete, view the return by clicking View/Print from the 
Data Entry Menu (or use CTRL+V). If anything was entered on the PDF screen, 
there will be three PDF-related items in the View/Print window:
• A “MESSAGES” alert (item #1 in Figure 37 on page 83) — EF Message 

1512

• An “EF Attachments” document (“EF PDF”) (blue squares) 

• An Attach PDF button on the toolbar (item #2)

2. Click the “EF PDF” file from the forms tree to see a list of all documents entered 
on the PDF screen.

3. Click the “MESSAGES” file to view EF Messages, including EF Message 1512, 
which includes information on how to attach the required documents to the return.

4. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF screen in data entry. An X in a red circle means 
the document has not yet been attached; a check mark in a green circle indicates 
an attached document (Figure 38).

Figure 37: The MESSAGES file (#1), and the Attach PDF button (#2)
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5. Select the row of an unattached document, and click Browse.
6. Navigate to the proper folder, select the PDF file to attach, and click Open (or 

double-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return (show a green check mark), recalculate the return. If all EF Mes-
sages have been resolved, the return is ready to be e-filed.

Removing PDF Attachments
You can remove a file attached to a return with the Delete button on the EF PDF 
Attachments dialog box, but then you will see EF Messages directing you to com-
plete the attachment. Removing the attached file does not eliminate the requirement 
that you attach the document - that remains and produces EF Messages.

To remove an attached file and also eliminate EF Messages associated with it:

• If it is listed on the PDF screen in data entry (a preparer attachment), removing 
the entry eliminates EF Messages associated with the attachment.

• For a program attachment, you must modify data entry so that the attachment is no 
longer necessary.

For more information to see links to relevant articles, see the Drake Software Knowl-
edge Base article, 11209: Attachments for E-filing - Removing a Return Attachment.

Importing Trial Balance Information
Drake Tax’s trial balance import feature allows data to be imported into a 1065 return 
from a trial balance worksheet. The trial balance template and importing function has 
the following benefits:

Figure 38: The EF PDF Attachments window
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• Eliminates the need to duplicate entries
• Reduces data entry errors by automatically importing data into the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

To use this feature, you need a copy of your client’s financial statements containing all 
the data needed to prepare a trial balance. This function does not export data. It creates 
an Excel spreadsheet in the form of a template that you can complete and import back 
into the return. All templates are created with $0 amounts entered—you enter the 
appropriate financial data on the template, and totals are displayed at the bottom. 
When data is entered, if credit and debit columns are out of balance, the worksheet 
highlights the out-of-balance amount. You can correct entries until a successful trial 
balance is displayed, and then import the completed trial balance information back 
into the return.

Preparing to Use Trial Balance Import
The trial balance import function can be used only on returns that were created in 
Drake Tax 2008 or later. Like several other functions of the tax program, this feature 
requires Microsoft Excel.

Take the following steps to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro settings are set to “Disable all macros with notification.” 

• (optional) Disable Autobalance in Drake Tax — When autobalance is disabled, 
the program is prevented from automatically adjusting the year-end retained earn-
ings or capital amounts, thus allowing you to see any discrepancies in the balance 
sheet. Autobalance can be disabled in two ways (a comparison of these methods 
can be seen in Figure 39 on page 86):
– (globally) From the Home screen of Drake Tax, select Setup > Options > 

Calculation & View/Print tab, and mark Turn off auto-balance of the bal-
ance sheet.

– (per-return basis) If you have autobalance enabled from setup options, you 
can disable it for a single return. To do so, from the PRNT screen of the 
return, select Reverse autobalance setup option. Alternately, if you have 
autobalance disabled from setup options, making a selecting from the PRNT 
screen will balance Schedule L for the open return.
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• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the partnership does not meet the filing requirement. If 
this is the case, you will have to override the default setting in order to have the 
amounts displayed on Schedule L. To force the Schedule L amounts to be printed, 
go to the PRNT screen, and select the Force Schedules L, M-1, M-2, & K-1 Sec-
tion L box.

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail work-
sheets (CTRL+W) that are not required. For example, the IRS does not require a 
detail worksheet for the Other income (itemize) field on the INC screen; if a 
return has a detail worksheet for that field, the trial balance will not be imported 
correctly into the return. Detail worksheets are indicated by red shading, as shown 
in Figure 40.

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 88 for more information on using detail worksheets in the trial balance.

Figure 39:  Methods for disabling autobalance

Figure 40: Example of an “unnecessary” detail worksheet



Drake Software User’s Manual - Partnerships (1065)

Tax Year 2020                                                                                               87 

Preparing Financial Data for Import
First, if you haven’t already, create a client file (open a new return) in Drake Tax 2020, 
or update an existing client file from the prior year. Then, create a trial balance work-
sheet (see “Opening a Template” below).

To prepare the financial data for importation, the data must be entered into Drake 
Tax’s specially designed trial balance template. Once this information is entered and 
saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.
2. Click Import > Trial Balance Import from the Data Entry Menu toolbar. The 

preliminary Trial Balance Import dialog box is opened.
3. Click Create New or Open Existing. If opening an existing file, click Open after 

selecting the correct file.

The trial balance template is displayed in Microsoft Excel.

File Location Whenever a new template is opened, the tax program assigns it a default file location 
and name. Trial balance templates are saved in the “TB” folder of your Drake20 pro-
gram.

NOTE
If saving a trial balance to a different location, make a note of where 
you store it. The program automatically looks in the default direc-
tory.

Template 
Structure

The trial balance template consists of six columns. These columns are described in 
Table 4.

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake Tax to which the debit or 
credit amount is imported

Reported on Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 91.
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Displayed at the bottom of the trial balance worksheet is the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount. Initially, 
as this is a template, all of the above listed amounts will be zero ($0).

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importation into data entry.

Entering Financial Data
When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

NOTE
Some data cannot be imported from the trial balance worksheet 
into the tax program and must be entered directly into the data 
entry fields within the Drake Tax program. For more on these cate-
gories of data, see “Special Conditions” on page 91.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0).

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons (Figure 41). If these cells do not work, you may need to activate 
them by enabling the content of the Excel sheet (see the Note in “Opening a Tem-
plate” on page 87).

Figure 41: An example of cells that require worksheets
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Click a worksheet button to open a worksheet in a new tab of Excel. Figure 42 shows 
an example of the “Other Income” worksheet. 

To return to the previous worksheet, click the Click to return to TB button above the 
worksheet tabs (#1 in Figure 42) or click the PTR TB tab (#2). Note that a detail tab 
might include one or more additional detail worksheets (#3).

IMPORTANT
Do not create detail worksheets in data entry of Drake Tax if the trial 
balance worksheet does not provide an equivalent detail worksheet; 
otherwise, the trial balance will not be imported correctly

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 43). 

Figure 42: The “Other Income” worksheet

Figure 43: Viewing the results of the trial balance
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In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the program.

NOTE
The data cannot be imported into Drake Tax if the worksheet is out 
of balance.

Once all necessary data for the client’s return has been entered and the worksheet is in 
balance, click the Save icon or select File > Save from the menu bar. To rename a file 
when saving, select File > Save As. Trial balance templates are saved in the “TB” 
folder of your Drake20 program.

Importing Data into a Return
Once a trial balance worksheet has been set up for a client in Drake Tax, the trial bal-
ance information can be imported into the program and calculated into the return.

IMPORTANT
Importing a trial balance overwrites existing data in the return. You 
should back up or archive the return prior to importing a trial bal-
ance, so that you have the option of restoring the original data. See 
“Archive Manager” in Chapter 5 of the 2020 Drake Tax User’s Manual 
for further information on creating archives of existing returns.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.
2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 

Trial Balance Import dialog box is opened.
3. Click Next.
4. Enter the name of or select the trial balance file to be imported. Use the Browse 

feature (red circle in Figure 44 on page 91) if necessary. By default, each trial bal-
ance file is an Excel (.xls) file displaying the client’s name and ending in “TB” for 
trial balance, as shown in the example in Figure 44. (See “File Location” on 
page 87.)
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5. Select any desired Trial Balance Additional Import Options.
6. Click Next, and wait for the import to be completed.
7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

NOTE
If the program does not calculate the trial-balance information as 
expected, you can return to the trial balance worksheet, make 
adjustments, and import the worksheet again.

Special Conditions
Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake Tax data entry. Other items should be entered into the 
worksheet for balance purposes but do not flow to data entry; these must be entered 
separately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items are imported directly to the location indicated in the program 
and on the return. For example, the amounts shown in Figure 45 go to screen L, line 1, 
column d, in the program and are shown on page 5, line 1, column d of the 1065 
return.

Figure 44: Importing the Trial Balance Worksheet into a return

Figure 45: Indication of where an amount will go in Drake Tax and on Form 1065



Drake Software User’s Manual - Partnerships (1065)

92 Tax Year 2020

The “Other Information” column in the trial balance worksheet indicates special con-
ditions and additional information regarding certain rows. Table 5 describes the most 
common notes in this column.

All “does not import” notes are accompanied by further instructions in the “Reported 
on” column, as shown in Figure 46.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule 
(screen) L) is required for an item marked “does not import” on the trial balance. 
(Figure 46)

To complete a SCH2 detail screen in the tax program:

Screen code: 
SCH2

1. Open the SCH2 screen for the return.
2. Select the appropriate line number from the Select line number... drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of Schedule L, press PAGE DOWN, and repeat steps 
2 and 3. Data is saved automatically upon entry.

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only; it is not 
included in the totals shown on the trial balance.

does not import Information cannot be imported and must be entered on the 
appropriate screen in Drake Tax. The screen and applicable 
field is specified in the “Reported on” column.

optional Amount is optional; it is not required for import, but could 
require direct entry in the program.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.

Figure 46:  SCH2 screen is required for “does not import” items
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When the return is produced, Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screens.

Depreciation Partnership (1065) returns can have up to four components of total depreciation:

• COGS 
• Real estate rental
• Rental other than real estate
• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that rental expense detail worksheets are 
required for 8825 and RENT depreciation.

NOTE
Enter 8825 and RENT depreciation amounts in the detail work-
sheets of the trial balance sheet for importing purposes. Be aware, 
however, that the 8825 and RENT screens in the program will have 
to be edited if any 4562 detail screens (see Figure 47) are used.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Schedule A on the return, and the rental depreciation 
expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, 
as applicable.

Because the remaining depreciation can 
comprise any number of assets, the amount 
entered on the trial balance does not flow to 
the return. To ensure that each component of 
the total remaining depreciation is calculated 
into the return, each asset must be entered on 
the applicable depreciation screens in data 
entry (Figure 47). Enter depreciable asset 
data on a 4562 detail screen, or enter the total 
depreciation on the override screens. 

NOTE
Entering the remainder of the depreciation on the trial balance 
worksheet helps ensure that the balance sheet balances and pro-
vides a way to check that the amount on line 1 of Schedule M-1 is 
correct. Compare the calculated line 1 amount at the bottom of the 
trial balance to the equivalent line on Schedule M-1 of the calcu-
lated return. If the depreciation amounts match but the line 1 
amounts differ, an M-1 adjustment could be required.

Rental 
Expenses

The following information applies only to partnerships with multiple rental properties.

Figure 47: 4562 detail screens
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The partnership trial balance includes lines for rental income and expenses. Both 
rental expense items require a trial balance detail worksheet (Figure 48). 

When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.
2. Enter the income totals on the trial balance sheet and the expense totals on the 

applicable detail sheets (click the buttons seen on Figure 48).
3. Ensure that the balance sheet is in balance.
4. Import the trial balance worksheet into the return. The applicable screens in data 

entry now contain the figures entered on the trial balance worksheet.
5. Compare the M-1, line 1, amount on the trial balance to the M-1, line 1, amount 

on the calculated return to ensure that they match.

NOTE
If the amounts do not match, review the imported amounts to 
ensure that all data was imported. If the data appears to have been 
imported correctly, an M-1 adjustment could be necessary.

6. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

7. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).
– To delete a screen in data entry, open the screen, and press CTRL+D. If a mul-

tiple forms list appears, be sure that the screen to delete is selected, then click 
Delete.

Other Program Imports
Information for other outside worksheets can also be imported into your 1065 return.

Figure 48: Entering data for rental income and expenses on the trial balance worksheet
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4562 Import With the 4562 Import function, you can import depreciable assets into Drake Tax 
from Excel worksheets, from a TAB (tab delimited) file, or a .CSV (comma separated 
value) file. After the import is completed, each asset or transaction appears on a sepa-
rate 4562 screen.

To successfully import depreciable assets from a worksheet into Drake Tax, the work-
sheet must be correctly formatted. The best and quickest way to get a properly format-
ted Excel worksheet is to download a template from Drake Software. To do so:

1. Open a client’s tax return.
2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.
3. Click the Form 4562 Import information and sample spreadsheet link to open 

Drake Software Knowledge Base article 15982 on downloading the worksheet 
template. (Also in that article is a 4562 Import link to an instructional video.)

4. Scroll to the bottom of the article, and click 1065 - 4562 Import Template to 
download the sample spreadsheet.

The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.

Use the worksheet to enter data for screen 4562. Each column aligns with its desig-
nated field on the 4562 screen—in other words, the spreadsheet columns follow the 
same order as would pressing TAB to navigate from one field to the next in Drake Tax.

Enter information into the spreadsheet as you would for a Form 4562. Note that if a 
column on the template is colored red, any data entered into said column will not be 
imported into Drake Tax. Be sure to use a separate row for each screen 4562. Once 
data entry is complete, save the Excel document, and import the completed sheet back 
into Drake Tax.

To use the 4562 Import feature:

1. Open a client’s tax return.
2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.
3. When you are ready to begin the import process, click Next.
4. When the Form 4562 Import - Step 1 window is opened, click Browse, find your 

worksheet, and click Open. Upon a successful upload, the Form 4562 Import - 
Step 2 window is opened automatically, with a condensed version the recently 
entered data appearing in the Form 4562 Detail Information section.

5. From the Start import at drop list, select the row where you wish to begin the 
import. (If the first row in the asset list is column headers, begin the import with 
row 2.) Click Next.

6. Click Import.

NOTE
Any data imported using the 4562 Import feature does not override 
already existing data in Drake Tax. Imported data will always create 

https://www.drakesoftware.com/service-learning/videos/4562-import/
https://www.drakesoftware.com/service-learning/videos/4562-import/
https://www.drakesoftware.com/service-learning/videos/4562-import/
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additional 4562 screens separate from those which are already 
present.

If you use an Excel worksheet from another source, you can still import the asset 
information into Drake Tax, but you need to be aware of certain parameters. For the 
asset information to be imported correctly:

• In an Excel workbook, the import data must be on the first sheet in the workbook.
– View the workbook and check the tabs across the bottom of the window. If 

there is more than one tab, click and drag the worksheet you want to use to the 
left until it is the first tab.

– The name on the tab does not matter.
• The import file must contain the specified columns in the specified order. Each 

column represents a field on the 4562 screen as determined by the column loca-
tion (not by the header labels, which are optional).

• Except for column headers, do not put anything in the import file that should not 
be imported.

• If you include column headers, make sure to start importing on the first data row, 
not the header row (in other words, start import at row 2).

• If totals are present, remove them. The totals may be imported, doubling your 
data.

• Enter dates using MMDDYYYY format (separators can be used or omitted).

Form 8949 
Import

With the Form 8949 Import/GruntWorx Trades feature, you can import capital gain 
and loss transaction data into Drake Tax from Excel worksheets, a TAB (tab delim-
ited) file, or a .CSV (comma separated value) file.

To successfully import transaction information from a worksheet into Drake Tax, the 
worksheet must be correctly formatted. (GruntWorx Trades are already properly for-
matted.) The best and quickest way to get a properly formatted Excel worksheet is to 
download a template from Drake Software. To do so:

1. From the Home window toolbar in Drake Tax, click Support > Knowledge Base.
2. When the Drake Software Knowledge Base is opened, in the Quick Search field 

in the top-right corner of the window, type 10139, and click the magnifying glass 
icon on the right.

3. After the search has been completed, click 10139: Schedule D, Form 8949, 
GruntWorx Trades Import from the Search Results.

4. Scroll to the bottom of the article and click the link: Drake20 Blank Excel 
Spreadsheet with 8949 Import Headers. (There is also a worksheet for years 
2016-2019, and 2015 and prior.)

The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.
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IMPORTANT
• For 1065 packages, the “TSJ” column represents the Property 
type field on screen 8949.

• If you are building your own worksheet for importing 8949 data, 
include the “QSBS” (Qualified Small Business Stock) columns in the 
worksheet but enter no amounts in those columns; when 8949 data 
is imported, those two columns are ignored.

• If building your own worksheet, do not include the EIN (QOF 
Only) field from screen 8949.

Enter information into the spreadsheet as you would on screen 8949. Be sure to use a 
separate row for each screen 8949. Once data entry is complete, save the Excel docu-
ment, and import the completed sheet back into Drake Tax.

To use the 8949 Import feature:

1. Open a client’s tax return.
2. From the Data Entry Menu toolbar, click Import > Form 8949 Import.
3. In the Form 8949 Import window, review the example spreadsheet format. When 

you are ready to begin the import process, click Next.
4. When the Form 8949 Import - Step 1 window is opened, click Browse, find your 

worksheet, click Open. Upon a successful upload, the Form 8949 Import - Step 
2 window is opened automatically, with a condensed version the recently entered 
data appearing in the Form 8949 Transaction Information section.

5. From the Start import at drop list, select the row where you wish to begin the 
import. (If the first row in the asset list is column headers, begin the import with 
row 2.) Click Next.

6. Click Import.

After import, each transaction appears on a separate 8949 screen.

Form 3115, Application for Change in Accounting Method
Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item. Drake Tax customers can complete Forms 3115 and related sched-
ules and attachments for partnership returns.

NOTE
Form 3115 must always be paper-filed.

Applicants filing Form 3115 should refer to IRS instructions for gen-
eral automatic change procedures and for a list of automatic 
changes to which the automatic change procedures apply.
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Accessing Screens for Changing Accounting Method
Several screens may be required to 
complete Form 3115. These screens 
are accessible from the Change in 
Accounting Method section, located 
under the Other Forms tab of the 
Data Entry Menu (Figure 49). The 
screens accessible from the Change 
in Accounting Method section 
include:

• Screen 3115 (Change in 
Accounting Method) — Used to 
access fields for Form 3115, 
including Schedules A through D

• Screen 311E (Schedule E) — 
Used to request a change in 
depreciation or amortization 
methods

• Screen ATT (Explanations and Attachments) — Used to create and view certain 
attachments to be generated by the software

• Screen ATT2 (Pt II Ln 14 & Pt III Ln 24b Attachment) — Used to complete cer-
tain parts of Form 3115 that require specific attachments

When you open screen 3115, the program displays the first of six screen tabs. As 
shown in Figure 50, you can access the various 3115 screens by clicking a tabbed link 
at the top of any of the 3115 screens.

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 50) 
that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake Tax. The first should be “1,” the second “2,” and so on. 
When using other screens, such as the 311E or ATT screens, you can use those num-
bers to indicate which instance of Form 3115 the 311E or ATT screen should be asso-
ciated with. If only one Form 3115 is being submitted, it is not necessary to enter 
anything in the Multi-form code box.

Figure 49: Form 3115 screens

Figure 50: Tab links for screen 3115
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TIP
See Screen Help (accessible from the 3115 screen toolbar, from the 
right-click menu, or by pressing CTRL+ATL+?) to access the Form 
3115 instructions through the IRS website.

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF Messages (as applicable) when the return is calculated. All forms, schedules, EF 
Messages, and worksheets are accessible from View/Print mode.

EF Messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen to the list of EF Messages in View/Print mode.

NOTE
All EF Messages must be eliminated before the return is eligible for  
e-file. EF Messages for Form 3115 attachments are eliminated when 
all required statements have been attached to the return.

EF “Notice” and EF “ACK” Pages
Similar to federal Form 9325, Acknowledgment and General Information for Taxpay-
ers who File Returns Electronically, generated with 1040 returns, the federal business 
packages generate an “EF Notice” page in View/Print mode for the main forms of fed-
eral returns, and state business packages generate a “(ST)EF ACK” page for the main 
forms of state returns.

These are Drake Tax-generated forms that serve the same purpose as Form 9325: an 
acknowledgment that a return has been transmitted through Drake Tax and received 
by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being 
processed) or an “R” ack (for a rejected return), the top section of the EF Notice is 
completed, noting the name and address of the client, the return type, the ERO who 
transmitted the return, and an indicator that the return was received by the IRS or 
applicable state agency.

When you download and process your acknowledgments and receive an “A” ack, the 
second section of the EF Notice is generated, indicating the return was accepted by the 
IRS or state agency and the date the return was accepted. The submission ID number 
is also included.
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